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Introduction
Introduction

Thank you for purchasing the HIOKI “Model 8910 CAN ADAPTER”. To
obtain maximum performance from the instrument, please read this
manual first, and keep it handy for future reference.

Inspection

When you receive the instrument, inspect it carefully to ensure that no
damage occurred during shipping. In particular, check the
accessories, panel switches, and connectors. If damage is evident, or
if it fails to operate according to the specifications, contact your dealer
or Hioki representative.

Accessories
Instruction manual ..................................... 1

CD-R ("8910 CAN set program" software
(Japanese/English 2 files) (for PC), CAN
setting function (for Memory HiCorder)) .... 1

RS-232C cable (D-sub 9-pin, male-female, 
straight cable) (Approx. 1.8 m) .................. 1

9418-15 AC ADAPTER ............................ 1



Inspection
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Options

Power cord ................................................ 1

9713-01 CAN CABLE (one end 
unprocessed) (Approx. 2 m) ...................... 1

9713-01 CAN CABLE (one end unprocessed) (Approx. 2 m)

9713-02 CAN CABLE (For automotive connector) (Approx. 2 m)
(Since this part is made to order, check the specifications document 
and delivery date.)

9714-01 LOGIC CABLE (one end unprocessed) (Approx. 1.5 m)

9714-02 LOGIC CABLE (for Memory HiCorder) (Approx. 1.5 m)

9165 CONNECTION CORD (Metal BNC - Metal BNC) (Approx. 1.5 m)

L9217 CONNECTION CORD (Metal BNC - Insulated BNC) 
(Insulated BNC for Memory HiCorder) (Approx. 1.7 m)



3
Inspection
Preliminary Checks
Before using the instrument the first time, verify that it operates
normally to ensure that the no damage occurred during storage or
shipping. If you find any damage, contact your dealer or Hioki
representative.

9557 RS-232C CARD (for Memory HiCorder)

Before using the instrument, make sure that the insulation on the
cords and cables are undamaged and that no bare conductors
are improperly exposed. Using the product in such conditions
could cause an electric shock, so contact your dealer or Hioki
representative for repair.
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Safety Notes

This manual contains information and warnings essential for safe
operation of the instrument and for maintaining it in safe operating
condition. Before using it, be sure to carefully read the following safety
precautions.

Safety symbols

The following symbols in this manual indicate the relative importance
of cautions and warnings.

This instrument is designed to comply with IEC 61010 Safety
Standards, and has been thoroughly tested for safety prior to
shipment. However, mishandling during use could result in injury
or death, as well as damage to the instrument. Be certain that you
understand the instructions and precautions in the manual
before use. We disclaim any responsibility for accidents or
injuries not resulting directly from instrument defects.

In the manual, the  symbol indicates particularly
important information that the user should read before
using the instrument.

Indicates AC (Alternating Current).

Indicates DC (Direct Current).

Indicates the OFF side of the power switch.

Indicates the ON side of the power switch.

Indicates that incorrect operation presents an
extreme hazard that could result in serious injury
or death to the user.

Indicates that incorrect operation presents a
significant hazard that could result in serious
injury or death to the user.

Indicates that incorrect operation presents a
possibility of injury to the user or damage to the
instrument.

Indicates advisory items related to performance
or correct operation of the instrument.
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Safety Notes
Mouse Operation

Indications
• Unless otherwise specified, “Windows” represents Windows 95, 98,

Me, Windows NT4.0, Windows 2000, or Windows XP.
• Dialogue box represents a Windows dialog box.
• Menus, commands, dialogs, buttons in a dialog, and other names

on the screen and the keys are indicated in brackets.

Click : Press and quickly release the left button of the mouse.

Right-click : Press and quickly release the right button of the
mouse.

Double click : Quickly click the left button of the mouse twice.

Drag : While holding down the left button of the mouse, move
the mouse and then release the left button to deposit
the chosen item in the desired position.

Activate : Click on a window on the screen to activate that
window.
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Measurement categories 

To ensure safe operation of measurement instruments, IEC 61010
establishes safety standards for various electrical environments,
categorized as CAT II to CAT IV, and called measurement categories.
These are defined as follows.

CAT II : Primary electrical circuits in equipment connected to an AC 
electrical outlet by a power cord (portable tools, household 
appliances, etc.)
CAT II covers directly measuring electrical outlet receptacles.

CAT III : Primary electrical circuits of heavy equipment (fixed 
installations) connected directly to the distribution panel, and 
feeders from the distribution panel to outlets.

CAT IV : The circuit from the service drop to the service entrance, and 
to the power meter and primary overcurrent protection device 
(distribution panel).

Using a measurement instrument in an environment designated with a
higher-numbered category than that for which the instrument is rated
could result in a severe accident, and must be carefully avoided.
Use of a measurement instrument that is not CAT-rated in CAT II to
CAT IV measurement applications could result in a severe accident,
and must be carefully avoided.
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Notes on Use
Notes on Use

Follow these precautions to ensure safe operation and to obtain the
full benefits of the various functions.

 Connecting the Cables (RS-232C Cable, CAN Cable,
Connection Cord [Analog], Logic Cable)

The ground (GND) conductors of the connecting cables* connect
in common to the Model 8910 chassis ground (they are not
isolated). Care is therefore necessary to ensure that there is no
potential difference between the instrument chassis ground and
the ground of any connecting device. Otherwise, the instrument
or connecting device could be damaged. Refer to “Power
Sources” below.
 Power Sources
The ground (GND) conductors of connecting cables* connect in
common to the Model 8910 chassis ground (they are not
isolated). Therefore, supplying power from different sources to
the instrument and a connecting device could cause electric
shock and equipment damage. To avoid these hazards, power
should always be supplied from the same source.
Even when power is supplied from the same source, as a result
of wiring, potential difference between grounds can result in
current flow through the connecting cables* that could damage
the equipment. 
To avoid such hazards, we recommend observing the following
precautions for power connections:
(1) When powering the 8910 from the supplied AC adapter,

before connecting devices to the 8910, plug the (supplied)
grounded power cord of the AC adapter into the same outlet
as that used to power the devices to be connected.
❖  2.2.1 Connecting the AC adapter (Page 16) and

2.3 Connection Procedure (Page 18)
(2) When powering the 8910 from a DC power source, before

making other connections, first connect the ground of the
8910 to the grounds of the devices to be connected. In this
case, always use the same power source.
❖  2.2.2 Connecting the DC Power Supply (Page 17) and

2.3 Connection Procedure (Page 18)
(3) When powering the 8910 from the supplied AC adapter and

powering connecting devices from a DC source (or when
powering the 8910 from DC and connecting devices from
AC), before making other connections to the 8910, first
connect the ground of the 8910 to the grounds of the
devices to be connected. Refer to the following alternatives
regarding common ground connection methods.
(a) Connect the grounds of devices running on DC power to

the AC adapter’s ground.
(b) Connect pin 3 (CAN_GND) of the 9713-01 CAN Cable to

the ground of the device to be connected.

*Connecting cables: Cables and connection cords being connected to the 8910.
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Note: In method (b) above, because of wire length and CAN cable
wiring conditions, some potential difference may remain
between grounding points, so we recommend (a) as the
preferred method.
❖  2.2.1 Connecting the AC adapter (Page 16),

2.2.2 Connecting the DC Power Supply (Page 17) and
2.3 Connection Procedure (Page 18)

 Power Supply Connections
Before turning the instrument on, make sure the supply voltage
matches that indicated on the its power connector. Connection to
an improper supply voltage may damage the instrument and
present an electrical hazard.
 Grounding the Instrument
To avoid electrical accidents and to maintain the safety
specifications of this instrument, connect the power cord
provided only to a 3-contact (two-conductor + ground) outlet.
❖  2.2 Power Supply Connections (Page 16)

 Before Powering on
Check the power supply is correct for the rating of the unit.

 Usage Precautions for the CD-R
• Always hold the disc by the edges, so as not to make fingerprints on

the disc or scratch the printing.
• Never touch the recorded side of the disc. Do not place the disc

directly on anything hard.
• Do not wet the disc with volatile alcohol or water, as there is a

possibility of the label printing disappearing.
• To write on the disc label surface, use a spirit-based felt pen. Do not

use a ball-point pen or hard-tipped pen, because there is a danger of
scratching the surface and corrupting the data. Do not use adhesive
labels.

• Do not expose the disc directly to the sun's rays, or keep it in
conditions of high temperature or humidity, as there is a danger of
warping, with consequent loss of data.

• To remove dirt, dust, or fingerprints from the disc, wipe with a dry
cloth, or use a CD cleaner. Always wipe radially from the inside to
the outside, and do no wipe with circular movements. Never use
abrasives or solvent cleaners.

• Hioki shall not be held liable for any problems with a computer
system that arises from the use of this CD-R, or for any problem
related to the purchase of a Hioki product.
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Notes on Use
 Installation Environment
• Do not use the instrument where it may be exposed to corrosive or

combustible gases. The instrument may be damaged.
• The instrument should be installed and operated indoors only,

between -10 and 55°C and 30 to 80% RH.
• Do not store or use the instrument where it could be exposed to

direct sunlight, high temperature or humidity, or condensation. Under
such conditions, the instrument may be damaged and insulation may
deteriorate so that it no longer meets specifications.
 Others
• To prevent an electric shock accident, confirm that the white or red

portion (insulation layer) inside the cable is not exposed. If a color
inside the cable is exposed, do not use the cable.

• Carefully read and observe all precautions in this manual.

• Using an connection cord other than that specified by HIOKI may
damage the BNC connector or result in measurement errors due to
contact failure.

• Even when using the 8910 within the permitted operating temperature
(-10 to 55°C) and humidity ranges, display on the LCD may become
difficult to read at very low or high ambient temperatures. (In such case,
alter the viewing angle.) Note that this change does not affect instrument
operation.

• This instrument may cause interference if used in residential areas.
Such use must be avoided unless the user takes special measures to
reduce electromagnetic emissions to prevent interference to the
reception of radio and television broadcasts.



Notes on Use

10



11
1.1  Overview
• 8910 CAN ADAPTER is a signal converter that acquires necessary
signals from CAN signals flowing on a CAN bus, converts the
signals to analog or logic signals, then generates output.

• The type of data to be acquired is set by using a PC, with settings
transferred and saved in internal memory of the 8910 via the RS-
232C.

• Internal memory can store up to 50 items of CAN definition data.
Since you can change allocated output channels by using the LCD
and operation keys on the front panel, the instrument can be used in
various applications without a PC.

Product

 Overview    Chapter 1
1.1 Overview
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1. Compact size and lightweight
The main unit is compact and lightweight for easy portability.

2. Ample output channels
The 8910 is equipped with ample output channels - 12 channels for
analog signal output and 24 bits for logic signal output.

3. Two independent input ports
Since CAN1 and CAN2 are independent, two networks with different
baud rates can be connected.

4. Automatic baud rate setting
Because the 8910 monitors the CAN bus and automatically sets the
baud rate, there is no need to manually set the baud rate. (Supported
baud rates are 125 kbps, 250 kbps, 500 kbps, and 1 Mbps.)

5. Detailed settings using a PC
Easy-to-use PC application software enables the detailed settings of
data to be acquired from a CAN bus.

6. Observation with your existing recorder
The output signal level ranges from -5 to +5 V, and the value is held
until subsequent signal output. Therefore, output from the 8910 can be
connected to an ordinary recorder. Thus, you can observe CAN
signals by connecting the 8910 to your existing recorder.

7. Real-time output
CAN signals are converted into analog/logic signals and output in real
time.

8. Mixed recording
By using the 8910 with a recorder such as the Memory HiCorder,
"sensor data or control signal on CAN" and "signal that cannot be
acquired on CAN" can be recorded together.

1.2 Major Features



13
1.3  Identification of Controls and Indicators
1.3 Identification of Controls and Indicators

Front Side

LCD display
20 characters x 2 lines, 
with backlight

Power LED
The LED indicates the power 
ON status of the instrument. 
The LED goes on in red when 
power is turned on.

CAN LED
The LED goes on in green when the 
CAN message assigned to the 8910's 
output channel is input.

Online LED
This LED indicates whether the 8910 and PC 
can communicate via the RS-232C.
The LED goes on in green when the ONLINE/
OFFLINE switch is set to the ONLINE side for 
enabling communication.
The LED goes on in orange when the 8910 is 
engaged in communication.

ESC (escape) key
Key used for various 
settings.

SEL (select) key
Key used for various 
settings.

ENT (enter) key
Key used for various 
settings.

CAL (calibration) key
In calibration mode, a 
calibration signal is output 
only while this key is pressed.

CAL LED
The LED goes on in green 
during calibration signal 
output.
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Back Side

 Analog Output Terminals
These terminals output analog 
signals. All 12 channels use BNC 
connectors.

 Logic Output Terminals
These terminals output logic signals. 
Each terminal outputs 4 bits, for a 
total of 24 bits.

Right Side

RS-232C Terminal
This is a communication 
connector for connecting 
a host PC or Memory 
HiCorder.

CAN Input Ports 1, 2
These ports are CAN signal 
input terminals. Since CAN1 
and CAN2 are independent, 
two different networks can be 
connected. These ports can 
also be used to supply power 
to the 8910.

Power Switch
This switch turns the power ON 
and OFF. The switch is effective 
for power supplied through 
DCIN, CAN1, and CAN2.

AC adapter connection Terminal
This terminal is used to connect the AC ADAPTER. 
(A DC power supply (10 to 30 V) can also be 
connected.)

ONLINE/OFFLINE Switch
This switch is used to set the 8910 to ONLINE 
or OFFLINE mode. Setting this switch to 
ONLINE enables the 8910 to communicate 
with the host PC or Memory HiCorder.

Key lock: Note that the 8910 accepts no key entry when the [ONLINE/OFFLINE] switch is set to the 
[ONLINE] side.
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2.1  Installation of the Instrument
1. Installation orientation
Install the instrument on a flat, level surface.

2. Ambient conditions
• Temperature : -10 to 55°C
• Humidity : 30 to 80%RH (with no condensation)

3. Do not use the instrument in the following locations:
• Subject to direct sunlight.
• Subject to high levels of dust, steam, or corrosive gases (Avoid

using the equipment in an environment containing corrosive gases
(e.g., H2S, SO2, NI2, and CI2) or substances that generate harmful
gasses (e.g., organic silicones, cyanides, and formalins).

• Subject to vibrations.
• In the vicinity of equipment generating strong electromagnetic fields.

Preparation Chapter 2

2.1 Installation of the Instrument
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2.2.1 Connecting the AC adapter

2.2 Power Supply Connections

• Use only the supplied Model 9418-15 AC ADAPTER . AC
adapter input voltage range is 100 to 240 VAC (with ±10%
stability) at 50/60 Hz. To avoid electrical hazards and damage to
the instrument, do not apply voltage outside of this range.

• To avoid electrical accidents and to maintain the safety
specifications of this instrument, connect the power cord only
to a 3-contact (two-conductor + ground) outlet.

1 Connect the AC adapter to the 8910.

2 Connect the AC adapter plug to an outlet.
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2.2  Power Supply Connections
2.2.2 Connecting the DC Power Supply
In addition to the AC adapter, any of the following power sources can
be used:
• DC power supply (10 to 30 V) (Voltage fluctuations of ±10% from

the rated supply voltage are taken into account.)
• Power supplied from CAN input port (10 to 30 V) (Voltage fluctuations

of ±10% from the rated supply voltage are taken into account.)
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Recommended Connection Procedures
(1) When powering the 8910 from the supplied AC adapter

Before connecting devices to the 8910, plug the (supplied) grounded
power cord of the AC adapter into the same outlet as that used to
power the devices to be connected. 

(2) When powering the 8910 from a DC power source 

Before making other connections, first connect the ground of the 8910
to the grounds of the devices to be connected. In this case, always
use the same power source. 

2.3 Connection Procedure

• To avoid the risk of electric shock, never connect the
connecting cables* of energized equipment to the 8910.

• The ground (GND) conductors of connecting cables* connect
in common to the Model 8910 chassis ground (they are not
isolated). Therefore, supplying power from different sources to
the instrument and a connecting device could cause electric
shock and equipment damage. To avoid these hazards, power
should always be supplied from the same source.
Even when power is supplied from the same source, as a result
of wiring, potential difference between grounds can result in
current flow through the connecting cable that could damage
the equipment. To avoid such hazards, we recommend
observing the following precautions for power connections:

*Connecting cables: Cables and connection cords being connected to the 8910.

Earth

Power

Outlet

Connecting
cables8910

AC
adapter

Device to be
coneected

GND

Connecting
Cables DC power source

(Battery or equiv.)
+
-

Device to be
connected

+
-

8910+
-
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2.3  Connection Procedure
(3) When powering the 8910 from the supplied AC adapter and
powering connecting devices from a DC source (or when
powering the 8910 from DC and connecting devices from AC)

Before making other connections to the 8910, first connect the ground
of the 8910 to the grounds of the devices to be connected. Refer to the
following alternatives regarding common ground connection methods.
(a) Connect the grounds of devices running on DC power to the AC

adapter’s ground.
(b) Connect pin 3 (CAN_GND) of the 9713-01 CAN Cable to the

ground of the device to be connected. 
Note: In method (b) above, because of wire length and CAN cable

wiring conditions, some potential difference may remain
between grounding points, so we recommend (a) as the
preferred method.

Earth

Power

Outlet

GND

9713-01
7 pin (CAN_H)
2 pin (CAN_L)
9 pin （CAN_V+)
3 pin （CAN_GND)

(b)

(a)

AC
adapter

DC power
(Battery or equiv.)8910 +

-
Device to be
connected

+
-
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The following diagram shows the connection points of the cables and cords to 

be connected to the 8910 CAN ADAPTER.

Connecting to the Analog Output

1. Align the BNC connector with the guide groove of the unit output
connector, and turn clock wise while pressing in to lock the connector.

2. To remove from the instrument, turn the BNC connector
counterclockwise to release the lock, then pull it.

The instrument does not output signals (including response bits) to the CAN
bus. Therefore, when only one device connected to the bus in addition to
the 8910, communication is not possible since response bits cannot be
exchanged. Therefore, be sure to connect the bus to which the 8910 is
connected with two or more devices to enable communication.

Connection Points

The 9714-01 or 9714-02 LOGIC CABLE (This is the 9714-02)
The 9165 or L9217 CONNECTION CORD

The 9713-01 or 9713-02 CAN CABLE
(This is the 9713-01)

RS-232C Cable

To prevent an electric shock accident, confirm that the white or
red portion (insulation layer) inside the cable is not exposed. If a
color inside the cable is exposed, do not use the cable.

Lock
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2.4  Power On/Off
Connect cables and cords before turning on the power.

When the power switch is turned on, the POWER LED goes on.

Confirm that the above display appears.    (X.XX is the version No.)

When initialization is complete, the display bellow appears and the
instrument enters CAN signal conversion mode.

Note that if no CAN data has been registered or assigned to any
output channel, the following error message will flash on the display:

2.4 Power On/Off

Check the following points before the power switch is turned on.
• When using the AC adapter, make sure that the power supply

complies with the rated voltage (100 - 240 VAC) and rated
frequency (50/60 Hz) of the 8910.

• The instrument is correctly connected.
❖  (Section 2.1, 15p.)

1 Connect the cables and cords.

2 Turn on the power.

3 The 8910 then begins internal initialization.

HIOKI
8910 CAN ADAPTER

8910 CAN ADAPTER
Ver X.XX

CONV MODE

Error Massages

Err:ASSIGN CH
NOT FOUND

Err:ASSIGN LIST
NOT FOUND

<When no CAN data is registered> <When no CAN data is assigned to
  an output channel>



2.4  Power On/Off
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• The error message continues flashing until a key is pressed.
• While the error message is displayed, RS communication is

disabled. To conduct RS communication, press any key to place
the instrument in conversion mode.
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3.1  Modes
The 8910 has the following three operation modes, which can be
switched by using keys on the front panel.

• Conversion mode is the first mode to become active after power is
turned on.

• This mode converts the CAN message supplied to CAN1 or CAN2
port according to internally set definition data, and outputs the
converted signal from a specified analog or logic output terminal.

When conversion mode is active, the LCD indicates the following: 

• The 8910 monitors the CAN bus and adjusts the baud rate
automatically. Therefore, the instrument has already begun to
receive signal input from CAN1 or CAN2 at this point.

• When the CAN message assigned to the output channel enters the
CAN port, the CAN LED goes on in green.

Operation Chapter 3

3.1 Modes

Conversion mode This mode converts the CAN signal input from
the CAN 1 or 2 port according to the set
definition data, and outputs the converted
signal from the specified analog or logic output
terminal.

Setting mode This mode is used to select data to be
acquired from the CAN bus and set the
channel for acquired data output.

Calibration mode This mode outputs a calibration signal.

3.2 Conversion Mode

CONV MODE

• The output voltage level is held until conversion of the next CAN
message.

• Four baud rates are supported: 125 kbps, 250 kbps, 500 kbps, and 1
Mbps.
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• This mode is used to set the data to be output from each analog/
logic output channel.

• The internal memory of the 8910 can store up to 50 items of CAN
definition data.

• The data in memory can be assigned to the 12 analog output
channels or six (24 bits) logic output channels for output.

3.3 Setting Mode

• CAN definition data must be set in advance using the PC application.
❖  Chapter 6, 49p
• The keys on the 8910 enable the following settings:

•Channel selection
•Label selection
•D/A conversion format/logic bit position
But the setting bellow cannot be made solely by using the 8910.
•CAN input port selection
•ID trigger setting
•ID filter setting 
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3.3.1 Activating setting mode

To use the keys on the 8910 for entering settings, position the
[ONLINE/OFFLINE] switch to the [OFFLINE] side. Make sure that the
ONLINE LED is off

When the instrument is in conversion mode, pressing the [SEL] key
changes the mode in the following sequence:

In setting mode, pressing the [ENT] key displays the following
indication:

The instrument is now in setting mode. ([*** OFF ***] appears when
the channel is not assigned with data for output.)

1 Position the [ONLINE/OFFLINE] switch to 
the [OFFLINE] side.

2 Press the [SEL] key.

3 In setting mode, press the [ENT] key.

CONV MODE

CAL MODE

SET MODE

[SEL] key

[SEL] key

[SEL] key

Conversion Mode

Calibration Mode

Setting Mode

Analog 01
*** OFF ***
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3.3.2 Contents of display in setting mode
When the data to be output is assigned, the label name and D/A
conversion format ([B] or [M]) of CAN definition data are indicated for
an analog channel; the label name and bit position are indicated for a
logic channel.

3.3.3 Selecting a channel number

When setting mode is activated, the channel number on the LCD
flashes, indicating that the channel selection can be changed.

In this condition, each time the [SEL] key is pressed, the channel
indicated on the LCD changes sequentially from analog channel 1 to
12. After analog channel 12, logic channels are shown in order of [A0]
to [F3], then the indication returns to analog channel 1. Hold down the
[SEL] key until the desired channel is shown.

After selecting a channel, press the [ENT] key. This enters the new
setting.

<Example of display for analog channel>

Analog 01
labelname M

Logic A0
labelname 0

<Example of display for logic channel>

1 Activating setting mode (Section 3.3.1, 25p.)

2 Push the [SEL] key, and select a channel.

01→02→03…12→A0→A1→A2→A3→B0→B1→B2→B3→C0
→C1→C2→C3→D0→D1→D2→D3→E0→E1→E2→E3→F0
→F1→F2→F3→ (returns to the beginning)

CH 

3 Push the [ENT] key.

Since CAN data conversion and output are in process for all channels
during channel number selection, the setting can be changed while
observing the output.



27
3.3  Setting Mode
3.3.4 Selecting the CAN definition data to be output

When the [ENT] key is pressed to enter the channel number, the
channel number stops flashing. At the same time, the label name of
CAN definition data starts flashing, indicating that CAN definition data
assigned to the output channel can be changed.

In this condition, pressing the [SEL] key changes the indication of the
label name. Hold down the [SEL] key until the label name of definition
data to be output is shown.

After selecting the CAN definition data to be output, press the [ENT]
key. This enters the setting.

1 Enter the channel number.
(Section 3.3.3, 26p.)

2 Press the [SEL] key, and select a label name.

3 Press the [ENT] key.

• To disable output, use the [SEL] key to select [*** OFF ***], then press
the [ENT] key.

• CAN data conversion and output are stopped for all channels while CAN
definition data is being selected.
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3.3.5 Setting the D/A conversion format/logic bit 
position

When CAN definition data is entered by pressing the [ENT] key, the
D/A conversion format ([B] or [M]) flashes for an analog channel; the
bit position flashes for a logic channel. 

Hold down the [SEL] key until the flashing section shows the desired
value.

To enter the D/A output format or bit position, press the [ENT] key.
This enters the new setting.

After the D/A output format or bit position is selected by pressing the
[ENT] key, the channel number indication starts flashing again.

1 Enter the CAN definition data.
(Section 3.3.4, 27p.)

2 Press the [SEL] key, and set the value.

3 Press the [ENT] key.

CAN data conversion and output are stopped for all channels while the D/A
conversion format/logic bit position is being set.

D/A conversion
format

This format is used to select analog signal output
in a range from -5 to +5 V or 0 to +5 V. Selecting
Bipolar [B] sets the output range from -5 to +5 V;
selecting Monopolar [M] sets the output range
from 0 to +5 V.
The D/A resolution is 16 bits in both cases. When
the data length is 16 bits, the relationship
between input data and output voltage is as
follows:(29p.)
(When the data length is N (bits), replace "16" in
the factorial of "2" shown in the diagram with "N"
in calculation.)
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3.3.6 Returning to conversion mode
After settings are made, press the [ESC] key several times to return to
conversion mode.
When no key entry is made for about 30 seconds, the 8910 also
returns to conversion mode.

<Bipolar> <Monopolar>

0.0V

-5.0V

+32767

-32768

+65535

0

0

-32768

0

0+32767

+32767

+5.0V

+2.5V

0.0V

+32767 +65535

(-2    )
16-1

(+2  -1)
16

(+2  -1)
16

(+2   -1)
16-1

(-2    )
16-1

(+2   -1)
16-1

(+2   -1)
16-1

(+2   -1)
16-1

+5.0V

Relationship between input data and output voltage

(With sign) (Without sign)

(With sign) (Without sign)

Bit position When the assigned CAN definition data is 2 bits
or more, this setting determines the type of bit
data that is output.
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• This mode is used to select an analog/logic output channel and
output a calibration signal from the selected channel.

• This mode lets you check for proper connection of the analog
connection cords and logic cables.

3.4.1 Activating calibration mode

To use the keys on the 8910 for entering settings, position the
[ONLINE/OFFLINE] switch to the [OFFLINE] side. Make sure that the
ONLINE LED is off.

When the instrument is in calibration mode, pressing the [SEL] key
changes the mode in the following sequence:

In calibration mode, pressing the [ENT] key displays the following
indication:

3.4 Calibration Mode

1 Position the [ONLINE/OFFLINE] switch to 
the OFF LINE side.

2 Press the [SEL] key.

3 In calibration mode, press the [ENT] key

CONV MODE

CAL MODE

SET MODE

[SEL] key

[SEL] key

[SEL] key

Conversion Mode

Calibration Mode

Setting Mode

Calibration A01
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3.4.2 Selecting a channel number

When calibration mode is activated, the channel number on the LCD
flashes, indicating that channel selection can be changed.

In this condition, each time the [SEL] key is pressed, the channel
indicated on the LCD changes sequentially from analog channel 1 to
12. After analog channel 12, logic channels are shown in order of A to
F, then the indication returns to analog channel 1. Hold down the [SEL]
key until the desired channel is shown.

3.4.3 Outputting a calibration signal
• After selecting a channel, press the [CAL] key to output a calibration

signal.The calibration signal is output from the selected channel
only while the [CAL] key is held down. 

• CAN data conversion and output are stopped for all channels during
calibration signal output.

• For an analog channel, the output alternates between 0 V and 5 V
at 100-ms intervals.

• For a logic channel, the output bit pattern alternates between 0Ah
(1010) and 05h (0101) at 100-ms intervals.

1 Activating calibration mode.
(Section 3.4.1, 30p.)

2 Push the [SEL] key, and select a channel.

Calibration A01

A01→A02→A03....→A12→LA→LB→LC→LD→LE→LF→(returns to the beginning)
CH 

<For analog channel> <For Logic Channel>

100ms 100ms

0 V

5 V

100ms

100ms

0

1

0

1

0

1

0

1

bit1

bit2

bit3

bit4
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3.4.4 Returning to conversion mode
• Press the [ESC] key to exit from calibration mode and return to

conversion mode.
• When no key entry is made for about 30 seconds, the 8910 also

returns to conversion mode.
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3.5 Operation Map

ESC SEL ENT CAL

HIOKI
8910 CAN ADAPTER

Err:ASSIGN LIST
NOT FOUND

Err:ASSIGN CH
NOT FOUND

8910 CAN ADAPTER
Ver X.XX

CONV MODE

ESC SEL ENT CAL ESC SEL ENT CAL

SEL

CAL MODE

SEL

SET MODE

SEL

ESC

ESC

ENT

ENT

Analog 01
Speed B

Calibration A01

SEL

ESC

ENT SEL CAL

ﾁｬﾈﾙ決定ﾁｬﾈﾙ選択

Analog 01
Speed B

SEL

ESC

ENT

ﾗﾍﾞﾙ決定ﾗﾍﾞﾙ選択

Analog 01
Speed B

SEL ENT

出力形式選択 出力形式決定

CAL出力ﾁｬﾈﾙ選択

ESC ESC

設定モード

変換モード

CALモード

         の部分は点滅表示です。

SYSTEM RESETモード

SYSTEM RESET
NO->ESC YES->ENT

Analog 01
*** OFF ***

■出力OFFの設定

   設定モードのﾗﾍﾞﾙ選択で 下図の表示となるように
   SEL ｷｰで選択し、ENT ｷｰにて決定することでﾁｬﾈﾙ出力OFFとなります。

indicates a flashing display.

Conversion Mode

Calibration ModeSetting Mode

Output OFF setting

When label change is possible in setting mode, use the [SEL] 
key to display the indication below, then press the [ENT] key. 
This turns off channel output.

While pressing the [ESC] key, [SEL] key, and [ENT] key
simultaneously, turn on the power switch of the 8910. 

Press the [ENT] key to
reset the system.

System Reset Mode

This will place the instrument in system reset mode.

Selection of channel Entering the channel
settings

Selection of label

Selection of output format Entering the output

Entering the label

format

Selection of channel Calibration signal output

:escape             :selection             :enter                :calibration
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ONLINE mode/OFFLINE mode

RS communication

1. When an error message is displayed
2. When the instrument is in system reset mode

Key operation

1. When an error message is displayed
2. When the instrument is in system reset mode

Display

1. When an error message is displayed
2. When the instrument is in system reset mode

CAN conversion and output

1. When the instrument is in conversion mode
2. While the [CAL] key is not pressed in CAL mode
3. When a channel is being selected in setting mode (with setting

changeable while observing the output)

Operate the switch to toggle between ONLINE mode and OFFLINE
mode.

In ONLINE mode, RS communication is enabled. The keys are not
operable in this mode (key lock).

In OFFLINE mode, the 8910 accepts operations. RS communication is
not possible in this mode.

Even when the instrument is in ONLINE mode, the ONLINE LED goes
off and RS communication is disabled in the following cases:

Keys are not operable when the instrument is in ONLINE mode (key
lock).

Even in ONLINE mode (key lock), pressing a key turns on the
backlight for about 10 seconds.

Even in ONLINE mode (key lock), the keys are operable in the
following cases:

The backlight turns off when no key entry is made for about 10
seconds.

The instrument returns to conversion mode when no key entry is made
for about 30 seconds.

The display remains on until a key is pressed in the following cases:

CAN conversion and output are in process for all channels in the
following cases:
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1. When the [CAL] key is pressed in CAL mode during CAL signal
output 

2. When the label, output format, or bit position is being selected in
setting mode

3. When the instrument is engaged in RS communication
4. When an error message is displayed
5. When the instrument is in system reset mode

Setting change

Operation tips

CAN conversion and output are stopped for all channels in the
following cases:

When the [SEL] key is used in setting mode to change a setting,
pressing the [ENT] key enters the new setting.

A new setting will not be effective by simply changing a setting with the
[SEL] key in setting mode.

The entered setting is written to backup memory immediately before
CAN conversion and output.

In setting mode, CAN conversion and output are conducted when
setting item selection returns to the channel selection. Therefore, the
setting is written to backup memory at this time.

If 8910 power is turned off before setting item selection returns to the
channel selection, the setting change made in setting mode will not be
written to backup memory.

In CAL mode, pressing the [SEL] key changes the channel indication
in the forward direction. Pressing the [SEL] key while holding down the
[ENT] key changes the channel indication in the reverse direction.

In setting mode, pressing the [SEL] key changes the setting item
indication in the forward direction. Pressing the [CAL] key changes the
setting item indication in the reverse direction.
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4.1  Overview
The 8910 CAN set program is the software used to set recording
conditions for the 8910 CAN ADAPTER. The program mainly consists
of 8910 setting mode and CAN definition data editing mode.

This mode is used to set the 8910 CAN ADAPTER.
In this mode, up to 50 items of CAN definition data to be registered in
the 8910 can be selected, with data to be output from the 8910 output
channel selected from the data registered. After setting is completed,
the setting data is transferred to the 8910 via the RS-232C.

This mode is used to create or edit a CAN definition data file.

Preparation of
the CAN Set 
Program Chapter 4
4.1 Overview

8910 setting mode

CAN definition data editing mode
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4.2.1 System requirements
To use the program, the following hardware and software are required:

4.2.2 Installation
Follow the procedure below to install the program.

1. Close all active applications.

2. Insert the CD-R provided into the CD-ROM drive.

3. Execute the Setup file on the CD-R.

4. The installer starts up. Follow the instructions displayed on the screen
to install the program.

4.2 Program Setup

Personal computer

IBM PC/AT compatible
Pentium 133 MHz or higher (recommended)
Min. 64 MB RAM (recommended)

Free hard disk space: 5 MB
RS-232C capability
CD-ROM drive (to install software)

OS

Microsoft Windows 95 (OSR2 or later)
Windows 98

Windows NT4.0 (SP3 or later)
Windows Me
Windows 2000

Windows XP

Assuming that your CD-ROM drive is drive R

(1) Click the [Start] button.
(2) Select [Run...] on the Windows Start Menu.
(3) Enter as following in the text box.

Using the English file : R:\8910SET\ENGLISH\SETUP.EXE
Using the Japanese file: R:\8910SET\JAPANESE\SETUP.EXE

(4) Click [OK].

 (otherwise, substitute the appropriate drive letter for R)
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4.2.3 Un-Installation
The program can be uninstalled by using one of the following
methods:

<Method 1>

1. Click the [Start] button to open the Windows Start Menu.

2. Select [Programs] - [HIOKI] − [8910 CanSet Program] - [Uninstall
8910 CanSet Program].

3. When a dialog box appears asking about file deletion, select [Yes].

<Method 2>

1. Click the [Start] button to open the Windows Start Menu.

2. Select [Settings] - [Control Panel]. 

3. Click the [Add/Remove Programs] icon to open the [Add/Remove
Programs Properties] dialog box.

4. Select [8910 CanSet Program] in the list shown in the [Add/Remove
Programs Properties] dialog box, then click the [Add/Remove].

The uninstaller starts up and deletes the program. Note that setting
files remain on the PC. Manually delete any unnecessary files. 
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5.1  Connecting the PC to the 8910
Before initiating the setting procedure, connect the PC to the 8910.
After connection is made, start up the setting application software.

Follow the procedure below to connect the PC to the 8910.

1. Turn off the power of the 8910.

2. Make sure that no cable is connected to the CAN1 or CAN2 port of the
8910.

3. Connect the RS cable to the RS-232C terminal on the 8910.

4. Connect the other end of the RS cable to the RS-232C terminal on the
PC.

5. Turn on the power of the 8910.

6. Position the [ONLINE/OFFLINE] switch to [ONLINE] side.

Starting the CAN
Set Program Chapter 5

5.1 Connecting the PC to the 8910
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1. Click the [Start] button to open the Windows Start Menu, then select
[Programs] - [HIOKI] - [8910 CanSet Program] - [8910 CanSet
Program].

2. The program starts up and the following 8910 setting window appears
on the display.

<To end the program>
Select [Close] or [Exit] on the [File] pull-down menu. Selecting
[Close] only closes the 8910 setting window. Selecting [Exit] closes
the 8910 setting window and CAN definition data editing window
(Section 6.6, 65p.) at the same time. 

5.2 Starting Up the Condition Setting 
Program

2.        3.                      8.      9.            10.            11.         13.

1.

4.
5.

6.

7.

14. 12. 
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1. Toolbar Various operations can be conducted by clicking
appropriate icons on the toolbar.
The colored icons effective in this window (from the
left) are: 
• [New] for the 8910 setting file
• [Open] for the 8910 setting file
• [New] for the CAN definition data file
• [Open] for the CAN definition data file
• [Save] for the currently open file
• [Save as] for the currently open file
• [Print] for setting data
Checking [Toolbar] on the [View] pull-down menu
displays the toolbar.

2. ID trigger setting The ID trigger is a function that outputs a pulse wave
from a selected logic channel at ID message input.
This section is used to enter the ID trigger setting.

3. CAN definition data file selection This shows the name of the CAN definition data list file
currently selected. To change the file, click the [...]
button on the right side.

4. CAN definition data edit button This button is used to edit CAN definition data. It
allows the editing of existing data and creation of new
data.

5. CAN port selection This is used to select CAN1 or CAN2 input port of the
8910 for data input.

6. CAN definition data list detail display Checking this item displays all setting items of
definition data in list format. When this setting is off,
only the necessary items are displayed.

7. CAN definition data list This section displays the content of the downloaded
CAN definition data file. In the initial state, the content
of the previously used file is displayed.

8. ID filter setting Each input port can be set with a filter to prevent the
reception of messages in standard or extended format.

9. 8910 registration list edit button This button is used for editing an 8910 registration list.
It allows the editing of an existing list and creation of a
new list.

10. 8910 registration list content This section displays the CAN definition data to be
registered on the 8910 CAN ADAPTER. Up to 50
items of definition data can be registered on the 8910.

11. Analog output allocation list This list displays the data to be output through analog
output channels 1 through 12 of the 8910 CAN
ADAPTER.

12. Logic output allocation list This list displays the data to be output through logic
output channels A through F of the 8910 CAN
ADAPTER. Each line on the display represents one bit.

13. Send button This button transmits the settings made in this window
to the 8910 CAN ADAPTER.
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14. Status bar This section indicates the current status. Checking
[Status bar] on the [View] pull-down menu displays
the status bar.



45
5.3  Menu Items in the Setting Window
5.3 Menu Items in the Setting Window 

[New]
[Open]
[Close]
[Save]
[Save as]
[Can Define Data File]
[Print]
[Print Preview]
[Print Setup]
[Exit]

❖ (Section 7.1.2, 72p.)

❖ (Section 7.1.1, 71p.)

❖ (Section 5.2, 42p.)

❖ (Section 9.1.2, 88p.)

❖ (Section 9.1.1, 87p.)

❖ (Section 9.2.1, 89p.)

❖ (Section 9.2.2, 89p.)

❖ (Section 9.2.3, 90p.)

❖ (Section 5.2, 42p.)

[New]

[Open]

❖ (Section 
6.6.2, 69p.)

❖ (Section 
6.6.3, 69p.)

[Modify Password] ❖ (Section 9.4, 93p.)

[Send]
[Settings]

❖ (Section 8.2, 84p.)

❖ (Section 8.1, 83p.)

[Toolbar]
[Status bar]

❖ (Section 5.2, 42p.)

❖ (Section 5.2, 42p.)

[Cascade]
[Tailed]

❖ (Section 9.3, 92p.)

❖ (Section 9.3, 92p.)

[About 8910 Can Set] ❖ (Section 9.5, 94p.)
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5.4 Operation Flowchart

1. Prepare for setting.

2. Set the CAN definition data.

• Connecting the PC to the 8910
Connect the PC to the 8910 via the
RS-232C.

• Starting up the 8910 CAN set
program

• Setting the message ID
Set the message ID.

• Setting the data length
Set the data size.

• Setting the data start position
Set the data location.

• Setting the data pattern
Set the data pattern
(byte arrangement).

• Setting the sign
Set whether the data has a sign.

• Setting the signal name/label
name
Set the name of the data.

• Setting the scaling
Set the physical quantity of data.

3. Register the definition data
in the registration list.

4. Set the ID filter.

• Loading CAN definition data
Read the data from the file.

• Registration of definition data in
the registration list
Select the data from the definition list
and register it.

• Setting the ID filter
Set the filter ON/OFF for each input
port.

5. Assign data to output channels. • Allocation of data to analog
channels
Set the output analog channels.

• Allocation of data to logic
channels
Set the output logic channels.

<Go to the next page>

• Selection of a message ID
Select an applicable message ID.

• Selection of output channels
Select a pulse output channel.

6. Set the ID trigger.
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7. Send the set data to the 8910. • Setting of communication
parameters
Set the communication parameters on 
the PC.

• Transmission of data
Transfer the data to the 8910.

8. Record the setting data. • Storage of set data
Save the set data.

• Printing of set data
Print the setting data.

9. End the setting procedure. • Ending the 8910 CAN set
program
Close the application software.
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6.1  Opening a CAN definition data file
• Parameters must be edited or created to acquire data from the CAN
bus.

• CAN definition data can be set using the 8910 setting window or by
opening the CAN definition data editing window. The following
describes how to set data in the 8910 setting window.

❖ How to use the editing window → (Section 6.6, 65p.)

6.1.1 Opening a CAN definition data file
The stored CAN definition data file can be read.

Click the [...] button located to the right of the CAN definition data file
name box to show the file loading dialog box.

From the list of CAN definition data files shown in the file loading
dialog box, select a file (with extension "cdf") to read.

Clicking the [Start] button on the dialog box updates the CAN
definition data list.

Setting the CAN
Definition Data Chapter 6

6.1 Opening a CAN definition data file

1 Click the [...] button.

2 Select a file.

3 Click the [Start] button.
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6.1.2 Creating a new CAN definition data file

Click the button located above the CAN definition data list to create a
new CAN definition data file. To prevent operation errors, only the
[Edit] button is operable under normal conditions. First, click this
button.

When the password protection function is enabled, the password input
dialog box opens. Enter the password. 
❖ Details of the password setting →(Section 9.4, 93p.) 

The [Edit] button remains depressed and the [New] button, [Add]
button become operable. (The Memo (comment) display (66 p.) also
becomes available for use.)

1 Click [Edit] button.

2 Enter the password.
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Clicking the [New] button opens a confirmation dialog box that asks
whether to initialize the CAN definition data file.

Clicking [OK] deletes the content of the currently displayed CAN
definition data list and executes initialization.

3 Click the [New] button.

OK Creates a CAN definition data file.

Cancel Cancels creation of a CAN definition data file.
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New definition data can be added to the currently open CAN definition
data file.

Click the [Add] button located above the CAN definition data list to
open the CAN definition data setting window.

This window is used to set items such as the message ID and start bit.

6.2 Editing the CAN Definition Data

1 Click the [Add] button.

2 Set items.

CAN definition data setting window

Setting of message ID

Setting of data start position

Setting of data length

Setting of data type

Setting of sign

Setting of signal name Setting of label name Setting of unit

Setting of scaling
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6.2  Editing the CAN Definition Data
6.2.1 Setting the message ID
• Set the message ID of the message in which data to be acquired is

stored.
• Since this instrument supports extended format, a value of up to 29

bits can be set in the message ID section. Enter numeric values in
hexadecimal notation.

6.2.2 Setting the data length
Enter the size (bits) of data to be acquired.

• Since the maximum size of data that can be captured by the 8910 is
2 bytes (16 bits), a value from 1 to 16 can be entered in the input
box.

• The data length set here, together with the data start position and
data pattern system settings, determines the location of acquisition
data in the CAN data frame.

 ID 0 to 1FFFFFFF

Example: When 64 is entered in the input box, this input is
interpreted as 100 in decimal notation since 64 in
hexadecimal notation is 100.

Length [bit] 1 to 16 (bits)
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6.2.3 Setting the data start position
The least significant bit (LSB) position of acquisition data is used to
specify its location in the CAN data frame.

The bit positions are numbered as follows:

1. As the reference position, the least significant bit (LSB) position of the
first byte of data in the data frame is given a value of 0. From there, the
number is increased by one towards the most significant bit (MSB)
position. 

2. From the MSB position, it moves to the next byte data, and the
number is incremented by one from the LSB toward the MSB.

3. Since the maximum size of the data frame section is 8 bytes (64 bits),
the MSB position in the 8th byte from the beginning is numbered 63.
Therefore, the bit positions can be expressed with numbers from 0 to
63, as shown below.

7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8

7 6 5 4

23 22 21 20 19 18 17 16

31 30 29 28 27 26 25 24

39 38 37 36 35 34 33 32

47 46 45 44 43 42 41 40

55 54 53 52 51 50 49 48

63 62 61 60 59 58 57 56

3 2 1 0

0

1

2

3

4

5

6

7

       bit
 byte

←MSB LSB→

↑
Beginning

End
↓

Example: 8-bit data in the second byte from the beginning is specified.

Since its least significant bit (LSB) position is Bit 0 in Byte 1, the bit position is 8.

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 ・・・

Massage beginning Massage end → 

Most significant bit Least significant bit

byte 0 byte 1 byte 2 byte 3
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6.2.4 Setting the data pattern
Here, the data pattern is set. Even if the data start position and data
length are the same, the data position (method of data acquisition)
varies depending on whether the data pattern is Motorola format or
Intel format.

The data pattern (method of data acquisition) is selected from the
following three systems:

Example: A data whose bit length is 10 bits and data start position (LSB position) is Bit 16.

<Motorola format> <Intel format>

7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8

bit
byte 7 6 5 4 3 2 1 0

0

1

23 22 21 20 19 18 17 162

31 30 29 28 27 26 25 243

7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8

bit
byte 7 6 5 4 3 2 1 0

0

1

23 22 21 20 19 18 17 162

31 30 29 28 27 26 25 243

23 22 21 20 19 18 17 169 8 23 22 21 20 19 18 17 1625 24(MSB) (LSB)  (MSB) (LSB)

The position of Bit 9 is the MSB
 (most significant bit) position.

The position of Bit 25 is the MSB
 (most significant bit) position.

U/L (Motorola) Data is extracted according to Motorola format.

L/U (Motorola) Data is extracted according to Motorola format,
then the high-byte and low-byte positions are
switched. This setting is effective when the data
length is from 9 to 16 bits. When the data length
is 8 bits or shorter, this setting function is the
same way as U/L (Motorola).

L/U (Intel) Data is extracted according to Intel format.
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6.2.5 Setting the sign
This is used to set whether the pertinent data has a sign.

When "with sign" is set in “positive → negative" sign conversion, one's
complement only interchanges 0 and 1 in binary notation, whereas
two's complement adds 1 after 0 and 1 are interchanged.

Example: In the 16-bit data shown in the diagram, when the value of Byte 0 is FF and the
value of Byte 1 is 00, the following value results according to the method used:

Value based on U/L (Motorola) : FF00
Value based on L/U (Motorola) : 00FF
Value based on L/U (Intel) : 00FF
(The data start position is 8 in Motorola format, and 0 in Intel format.)

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 ・・・

byte 0 byte 1 byte 2 byte 3

Data frame beginning Data frame end → 

Unsigned Without sign

1-Signed With sign
(with negative number being one's complement)

2-Signed With sign
(with negative number being two's complement)

Example: Data with a data length of one byte
Unsigned : 0 to +255 (00h to FFh)
1-Signed : -127 to +127 (80h to 7Fh)
2-Signed : -128 to +127 (80h to 7Fh)

-1 in 2-Signed is FFh, but -1 in 1-Signed results in FEh.

When the data length is 1 bit, only Unsigned can be selected.
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6.2.6 Setting the signal name
A signal name with up to 40 characters can be assigned to data.
• Click the signal name input box, then enter a signal name.
• The signal name is useful for identifying data among other data

used in the condition setting program. A comment can be entered
as the signal name.

• When the 8910 CAN ADAPTER is used with the HIOKI 8826, 8841,
8842 MEMORY HiCORDER, the signal name can be transferred to
the 8826, 8841, 8842 MEMORY HiCORDER as comment data.

6.2.7 Setting the label name
The label name must be set for each item of data since data is
distinguished by the label name on the 8910.
• Make sure that the same label name is not used twice.
• Up to 16 characters can be used in the label name. To enter a label

name, click the label name input box, then enter a name.

6.2.8 Setting the unit
Data can be attached with a unit of physical quantity with up to 8
characters. 
• Click the unit input box, then enter a unit.

Spaces or commas cannot be used in a signal name.

Spaces or commas cannot be used in a label name.

Spaces or commas cannot be used in an unit.
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6.2.9 Setting the scaling
• Data can be set with a physical quantity.
• Since the output voltage from the 8910 CAN ADAPTER is

determined by the data length setting, sign setting, and D/A output
setting, the setting value entered here is not reflected in the actual
output value.

• However, this setting is useful for understanding the possible range
of physical quantity of actual data.

• When the 8910 CAN ADAPTER is used with the HIOKI 8826, 8841,
8842 MEMORY HiCORDER, the scaling setting on the 8826, 8841,
8842 MEMORY HiCORDER side can be automatically adjusted
according to the value set here.

The conversion bit rate/offset value or maximum value/minimum value
can be used to specify scaling. Select one of the two methods.

Select the radio button next to [BitRate] when using the conversion bit
rate/offset value to specify the scaling.

Based on the physical quantity per bit of acquisition data and the offset
value, the physical quantity can be expressed by the following formula:

Specifying with conversion bit rate/offset value

1 Select the radio button next to [BitRate].

BitRate Physical quantity per 1 bit of acquisition data

Offset Offset value

2 Set the [BitRate] and [Offset] value.

Example: When the [BitRate] is set to 0.1 and [Offset] to 100 as
shown above, and the acquired data value is 500, the
physical quantity
Physical quantity = 500 x 0.1 + 100 = 150

Physical quantity = BitRate X Data value (Bit) + Offset
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When the [BitRate] or [Offset] is set, the [Maximum] and [Minimum]
values are automatically set based on the set values, data length
setting, and sign setting.

Select the radio button next to [Minimum] when using the maximum
and minimum values to specify the scaling

Set the [Maximum] and [Minimum] possible values of the data.

When the [Maximum] and [Minimum] value is set, the physical
conversion bit rate and offset value are automatically set based on the
set values, data length setting, and sign setting.

Specifying with maximum and minimum values

1 Select the radio button next to [Minimum].

2 Set the [Maximum] and [Minimum] value.
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6.2.10 Error Massage
If the CAN definition data settings are incorrect or conflicting, an error
message appears when the [OK] button is clicked.
If an error message appears, take the following corrective action:

The message ID or label name input box (or both) is blank. Neither the
message ID input box nor label name input box can be left blank. Be
sure to enter a setting in both boxes.

The data length, data start position, and data pattern settings
determine the location of acquisition data in the CAN data frame, but
current settings deviate from the range of the CAN data frame.

Confirm that the data length, data start position, and data pattern
settings do not cause any conflict.

If error message "Input please" appears

If error message "Bad Can define data!" appears

Example:
Data Length : 10 bits
Data start position : 0 (Bit 0 in Byte 0)
Data pattern : U/L (Motorola)
When the settings above are entered, the two high-order bits are outside the CAN data frame,
as shown below.

In this case, the problem can be corrected by changing the data length to 8 bits, data start
position to 14 (Bit 6 in Byte 1), or data pattern to L/U (Intel).

　 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4

9 8 7 6 5 4 3 2 1 0

　

byte 0 byte 1

Two high-order bits extend from the frame
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6.3  Deletion of CAN Definition Data
The definition data in the current CAN definition data file can be
deleted as follows:

When the definition data to delete is selected in the CAN definition
data list and the [Del] button located above the list clicked, the deletion
confirmation dialog box opens.

6.3 Deletion of CAN Definition Data

1 Click the [Del] button.

2 Click the [Yes] or [No] button.

Yes Deletes the selected definition file.

No Cancels deletion of the selected definition file.



6.4  Closing the CAN Definition Data File (Saving the File)

62
To close the currently open CAN definition data file, click the
depressed [Edit] button.

If the content of the CAN definition data file has been changed, a
dialog box appears, asking whether to save the changes you made.
Select [OK] or [Cancel].

All items of CAN definition data shown in the CAN definition data list
are saved, and the file will have extension cdf.

6.4 Closing the CAN Definition Data File 
(Saving the File)

1 Click the [Edit] button.

2 Click the [OK] or [Cancel] button.

OK Closes the open definition data file after saving the
changes.

Cancel Closes the open definition data file without saving the
changes.
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6.5  CAN Definition Data List Detail Display
The CAN definition data list usually shows only five items (as follows)
due to limited space:
• Number
• Signal name
• Label name
• Unit
• Data length
However, when the box next to [Detail] is checked, six additional items
(as follows) are displayed, so that all setting items of definition data
can be checked on the screen:
• ID
• Start bit
• Data pattern
• Sign
• Conversion bit rate
• Offset value

When a detailed display is shown, the display area can be moved by
using the scroll bar at the bottom of the list pane to check all items.

6.5 CAN Definition Data List Detail Display

<Simplified display> <Detailed display>
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<Moving the display area>
The size of the CAN definition data list display area can be changed. 

Position the cursor on the border between the CAN definition data list
and 8910 registration list so that the cursor changes into a double
arrow pointing left and right. Then, left-click the mouse.

Keep clicking the mouse, and drag to the left or right to adjust the size
of the display area.

1 Move the cursor, and left-click the mouse.

2 Drag the mouse.
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6.6  Editing in Another Window
In addition to the 8910 setting window, the CAN definition data editing
window can be used for setting CAN definition data.

6.6.1 Opening a new window

Select [CAN Define Data File] on the [File] pull-down menu in the
8910 setting window.

When a new menu opens, select [New] or [Open].

When the password protection function is enabled, the [Input
Password] dialog box opens. Enter the password.
❖ Details of the password setting → (Section 9.4, 93p.)

6.6 Editing in Another Window

1 Select [File] - [CAN Define Data File].

2 Select [New] or [Open].

New Creates a new file.

Open Opens an existing file.

3 Enter the password.
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A dedicated window for CAN definition data editing opens.

4 A window opens.

1. Toolbar Clicking color icons on the toolbar executes the following
operations:
The icons effective in this window are (from the left): 

• [New] for the 8910 setting file

• [Open] for the 8910 setting file
• [New] for the CAN definition data file
• [Open] for the CAN definition data file
• [New] for the CAN definition data
• [Edit] for the CAN definition data
• [Delete] for the CAN definition data
• [Save] for the currently open file.
• [Save as] for the currently open file.
Checking [Toolbar] on the [View] pull-down menu displays the
toolbar.

2. Memo (comment) display A comment regarding the CAN definition data file can be entered
and displayed.

3. Number of registered data
items display

The number of CAN definition data items registered in the CAN
definition data file is displayed.

4. CAN definition data
list display

This section displays the settings of CAN definition data
registered in the CAN definition data file. Double-click an item to
edit the definition of that item.

5. Status bar This section shows the current status.
Checking [Status bar] on the [View] pull-down menu displays the
status bar.

1.
2.

4.

5.

3.
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6.6  Editing in Another Window
<To End>
Select [Close] or [Exit] on the [File] pull-down menu. Selecting
[Close] only closes the CAN definition data editing window. Selecting
[Exit] closes the CAN definition data editing window and 8910 setting
window (Section 5.2, 42p.) at the same time.
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Menu Items in the CAN Definition Data Editing 
Window

[New]
[Open]
[Close]
[Save]
[Save as]
[Print]
[Print Preview]
[Print Setup]
[Exit]

❖ (Section 6.6.2, 69p.)

❖ (Section 6.6.3, 69p.)

❖ (Section 6.6.1, 65p.)

❖ (Section 6.6.5, 69p.)

❖ (Section 6.6.5, 69p.)
Cannot be used in CAN definition data editing
mode.

❖ (Section 9.2.3, 90p.)

❖ (Section 6.6.1, 65p.)

[Modify Password] ❖ (Section 9.4, 93p.)

[Toolbar]
[Status bar]

❖ (Section 6.6.1, 65p.)

❖ (Section 6.6.1, 65p.)

[Cascade]
[Tailed]

❖ (Section 9.3, 92p.)

❖ (Section 9.3, 92p.)

[About 8910 Can Set] ❖ (Section 9.5, 94p.)
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6.6  Editing in Another Window
6.6.2 Creating a new CAN definition data file
Select [New] on the [File] pull-down menu or click the following icon
on the toolbar to create a new CAN definition data file.

6.6.3 Opening a CAN definition data file
Select [Open] on the [File] pull-down menu or click the following icon
on the toolbar to open another CAN definition data file.

6.6.4 Editing CAN definition data
The definition data can be edited by double-clicking an item on the list,
by using the pull-down menu, or using the toolbar. 
❖ How to edit the data → (Section 6.2, 52p.)

The three icons above on the toolbar are used for editing: [Add new
data], [Edit selected data], and [Delete selected data] (from left to
right).

6.6.5 Saving CAN definition data
The pull-down menu or toolbar icon can be used to save the currently
open file.

The two icons above on the toolbar are used for saving data: [Save]
and [Save data as] (from left to right).
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7.1  Registration List Operations
The center pane of the window is a list used for registering CAN
definition data to be transferred to the 8910 CAN ADAPTER.
The following items are listed:

From the left:
• Item no.
• CAN port no.
• Signal name
• Label name
• Unit
• Data length
Up to 50 items of CAN definition data can be registered on the 8910.

7.1.1 Opening a registration list

Select [Open] on the [File] pull-down menu or click the icon on the
toolbar to download a stored 8910 setting file.

From the 8910 setting files displayed in the file read dialog box, select
the desired file (with extension cmu).
Executing the file read command updates the 8910 registration list and
analog/logic output allocation list.

Settings Chapter 7

7.1 Registration List Operations

1 Select [file] - [Open] or clicking the icon .

2 Select the desired file.
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7.1.2 Creating a registration list (registering definition 
data to a registration list)

• To create a new registration list, a definition data list must be read
from a stored CAN definition data list file.

• Then necessary data must be selected from the downloaded
definition data and registered in the registration list for data transfer
to the 8910.

❖ If there is no CAN definition data file, create a file. → (Chapter 6, 49p.).

Selecting [New] on the [File] pull-down menu or clicking the following
icon on the toolbar deletes and initializes the contents of the 8910
registration list and analog/logic output allocation list. When the
registered contents already exist, a confirmation dialog box appears
prior to deletion.

Clicking the [New] button located above the 8910 registration list
produces the same result.

Click the [...] button located to the right of the CAN definition data file
name box to show the file loading dialog box.

From the list of CAN definition data files shown in the file loading
dialog box, select a file (with extension "cdf") to read.

Clicking the [Start] button on the dialog box updates the CAN
definition data list.

1 Creating a new document.

1 Select [File] - [New] or click the icon .

2 Downloading a CAN definition data file

1 Click [...] button.

2 Select a file.

3 Click the [Start] button.



73
7.1  Registration List Operations
Clicking an item in the 8910 registration list selects data to be
registered in the list. The line selected is highlighted.

Multiple lines in the CAN definition data list can be selected by clicking
while holding down the [Shift] or [Ctrl] key.

The CAN port setting section is located above the CAN definition data
list pane.

Select CAN1 or CAN2 port of the 8910 to input the selected definition
data.

The highlighted line in the CAN definition list can be added to the 8910
registration list by dragging and dropping, or by clicking the [Add]
button above the 8910 registration list.

3 Selecting data

4 Selecting a CAN port

5 Registering from the CAN definition list to the 8910 registration list

Register by 
drag & drop.

OR
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If definition data with the same name has already been registered in
the registration list, a dialog box appears, asking whether to overwrite
the previous data.

The items (up to 50) registered in the 8910 registration list are sent to
the memory of the 8910.

7.1.3 Deleting data from the registration list

Clicking an item on the 8910 registration list highlights the line
selected. 

When there is a highlighted line in the 8910 registration list, the [Del]
button located above the 8910 registration list becomes operable.
Clicking this button deletes the item selected.

OK Overwrites existing data and registers new data
in the list.

Cancel Stops the registration of data in the list.

1 Click an item.

2 Click the [Del] button.
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7.2  Allocation to Output Channels
7.2.1 Setting analog output channels
The data to be acquired by the 8910 must be selected from items
registered in the 8910 registration list, and a channel must be selected
to output that data.

Selecting and clicking an item in the 8910 registration list highlights
the line selected.

When the highlighted line is dragged and dropped onto a channel
section in the analog output allocation list, it is assigned to that output
channel.

7.2 Allocation to Output Channels

1 Select and click an item on the registration 
list.

2 Drag and drop the item on to a channel 
section.

Register by 
drag & drop.
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After allocation is completed, the D/A conversion format setting dialog
box opens. Select bipolar or monopolar. This setting determines
whether the analog signal is output in a ±5 V range or 0 to 5 V range.
❖ Section 3.3.5, (28p.)

7.2.2 Deleting registered data from the analog output 
allocation list

When an item to be deleted from the analog output allocation list is
right-clicked.

A dialog box appears, asking whether to delete the data. Click [Yes] to
delete the selected line

3 Select [B(+/-)] or [M(+)].

B(+/-) Bipolar ...........Analog signal is output in ±5 V range.

M(+) Monopolar .....Analog signal is output in 0 to 5 V range.

Double-clicking a registered channel can also set the D/A conversion
format. Therefore, the type of D/A conversion can be changed after
registering the data in the analog output allocation channel.

1 Select an item to be deleted, and right-click.

2 Click [Yes].
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7.2.3 Setting logic output channels
Logic output channels are set the same way as for analog output
channels.
❖ Section 7.2.1, (75p.)
When assigned data is 2 bits or larger, the data is automatically
allocated so that the most significant bit is assigned to the channel
selected, with the rest allocated to the following channel.

Example 1: Data with label name [abc] and a data length of 5 bits assigned to Bit 1 in Ch A
is allocated as shown below.

In this example, if another signal is already allocated to 3 bits from Bit 2 to Bit 0 in Ch B, the
original signal only remains in Bit 0 in Ch B because overlapping bits are overwritten in one
bit units.
Example 2: Dragging and dropping data with a data length of 3 bits to Bit 3 in Ch A.

3

CH A

2 1 0 3 2 1 0

CH B CH C

1 0 3 2

3 2 1 04
A1 abc bit4
A0 abc bit3
B3 abc bit2
B2 abc bit1
B1 abc bit0
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7.2.4 Deleting data from the logic output allocation list

When an item to be deleted from the logic output allocation list is right-
clicked.

A dialog box appears, asking whether to delete the data. Click [Yes] to
delete the selected line.

For logic output channel deletion, data can only be specified by line
(bit).

1 Select an item to be deleted, and right-click.

2 Click [Yes].
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7.3  Massage ID Trigger
• The message ID trigger outputs a pulse (H active) with a width of
100 μs from the logic channel selected when a specified ID
message is input. 

• This is effective when using this instrument in combination with a
recorder with a trigger function.

7.3.1 Setting the message ID trigger
[ID_TRIGGER] located at the left-upper corner of the window is used
to set the message ID trigger.

Checking the check box enables the trigger function.

When the trigger function is turned on, the no. of the message ID for
triggering signal output must be entered in the [M_ID] input box.

7.3 Massage ID Trigger

Analog/logic output is held until the next CAN message is converted.
Therefore, setting the ID trigger does not allow you to observe the output
pulse even when a logic output is held H. In such case, turn off the power of
the 8910, then turn it back on and set the logic output to L before setting the
ID trigger.

1 Check the [ID_TRIGGER] box.

2 Input the massage ID number.

Example: Entering message ID100 outputs a signal from the logic
channel selected.

Deselecting the [ID_TRIGGER] check box deactivates the
message ID trigger function.

If communication with the 8910 is performed with the [ID_TRIGGER]
check box selected, but with no number entered in the [M_ID] input box, a
transmission error occurs and communication will be aborted.
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7.3.2 Setting output channels
Multiple logic channels can be specified for ID trigger output. 

Double-clicking a logic channel to be specified as an output channel
changes the corresponding icon to red and sets the channel as an
output channel.

When a channel is set as an output channel, the icon changes to red.
Moreover, the signal name column shows [ID TRIGGER] and the label
name column indicates the message ID set as a trigger. The Bit will be
fixed at 1.

1 Double-click a logic channel.

• When a channel already assigned with output data is specified, that
channel outputs both the assigned data and ID trigger simultaneously.
When reliable detection of the ID trigger is important, select a channel
without output data assigned.

• When the ID filter is enabled, the ID set with the ID trigger function is
filtered, thus disabling the ID trigger. (When the ID set with the ID trigger
function is allocated to another channel, i.e., not that of the ID trigger, the
ID trigger is enabled.)
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7.4  Setting the ID Filter
Individual input ports can be applied with a filter to inhibit the reception
of messages other than those assigned to the output channels.
• The filter results in the acquisition of standard format or extended

format only.

• The filter can improve acquisition performance.

7.4 Setting the ID Filter

STD ID filter allows the acquisition of standard format only.

EXT ID filter allows the acquisition of extended format only.

NON ID filter is disabled, and both standard and extended
formats can be acquired.



7.4  Setting the ID Filter

82



83
8.1  Setting Communication Parameters
The CAN definition data registered in 8910 registration data, and the
analog/logic channel allocation settings can be transferred to the
8910.

Select [Settings] on the [Comm] pull-down menu, The [Comm
Condition] dialog box is opened.

Make the following RS-232C settings:
• [Baud Rate] to 19.2 k
• [Data Bits] to 8
• [Parity] to None
• [Stop Bits] to 1.
For [Port], select the RS port used on the PC side.

Transfer of 
Setting Data 
to the 8910      Chapter 8

8.1 Setting Communication Parameters

1 Select [Comm] - [Settings].

2 Make the RS-232C settings.
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1. Make sure that the 8910 is connected to the PC.

2. Make sure that the CAN1 and CAN2 ports on the 8910 are not
connected to any cable.

3. Set the 8910 to ONLINE mode. (Position the [online/offline] switch to
[ONLINE] side.)

4. Execute transfer by selecting [Send] on the [Comm] pull-down menu.

5. A progress bar appears during write operation to indicate the status of
writing.

6. When transfer operation is completed, a dialog box appears for
reporting that the conditions have been set.

8.2 Executing Data Transfer
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8.3  In Case of Errors
8.3 In Case of Errors

Error Display Indication Check items

Indicates that the 8910
was not found during
data transfer.

• Are all cables properly connected?
• Are the communication settings

correct?
• Is there no cable connected to the

CAN1 or CAN2 port on the 8910?

Indicates that the 8910
was found, but
communication operation
failed.

• Is the [ONLINE/OFFLINE] switch
positioned to [ONLINE] side?

Indicates that the
message ID trigger
setting is incomplete.

If the message ID trigger setting is 
turned ON (with the [ID_TRIGGER] 
check box selected),
• Is a trigger ID set (ID no. in [M_ID]

input box)?
• Is a logic channel set for signal

output?

If an error occurs, the 8910 may remain in Remote mode (with the ONLINE
LED lit in orange). In this case, retransmit the data to exit Remote mode.
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The presence of duplicate bits is automatically checked when
transferring setting data.

If duplicate bits are found, the following items are displayed.
• Registration list item no.
• Massage ID
• Signal name of the duplicate data

The transfer operation can be resumed or cancelled.

8.4 Duplicate Bit Check

OK Transfer data to the 8910.

Cancel Cancels data transfer to the 8910.
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9.1  Saving the Setting Data
The settings can be saved on a specified destination media.

9.1.1 Saving data with a new name
The data edited in 8910 setting mode can be saved with a new name
by selecting [Save as] on the [File] pull-down menu or clicking the icon
below on the toolbar.

1. Select [Save as] on the [File] pull-down menu or clicking the icon
below on the toolbar. The  file save dialog box is shown.

2. Enter a file name in the file save dialog box.

3. Click the [OK] button.

4. The 8910 registration list and analog/digital output allocation list are
saved as an 8910 setting file with the specified name.

The file contains:
• List items registered in 8910 registration list (up to 50 items)
• Analog output channel allocation settings (12 channels)
• Logic output channel allocation settings (24 channels)

The file has extension "cmu."

Functions of the
Setting ProgramChapter 9
9.1 Saving the Setting Data
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9.1.2 Overwriting
The current setting data can be written over an existing 8910 setting
file by selecting [Save] on the [File] pull-down menu or clicking the
icon below on the toolbar.

If the current list has no file name, such as for a newly created file,
executing the [Save] command prompts the [Save as] command.

Executing the [Save] command overwrites an existing file with the current
list content. Careless use of this command may result in the loss of current
list data.



89
9.2  Setting Data Printout
9.2.1 Printing
The content of 8910 setting data can be printed by selecting [Print] on
the [File] pull-down menu or clicking the icon below on the toolbar.

The printed information includes the contents of the 8910 registration
list and analog/logic output allocation list.

The header section indicates model no. 8910 and the date, and print
as follows:
• Registration list data (i.e., port, signal name, label name, unit, data

length)
• Analog channel settings (i.e., channel no., signal name, label name,

unit, D/A)
• Logic channel settings (i.e., channel no. - bit, signal name, label

name, assigned bit).

❖ Actual printouts→(Section 9.2.4, 90p.)

9.2.2 Print preview
Prior to printing, the print image can be displayed on the screen by
selecting [Print Preview] on the [File] pull-down menu.

9.2 Setting Data Printout

HIOKI 8910
YYY/MM/DD hh:mm:ss

CAN ADAPTER DATA LIST

No.     Port        Name          Label           Unit     Length(bit) 
xx      xx          xxxxxxxxx     xxxxxxxx        xxxxx    xx

ANALOG
Ch      Name        Label         Unit   D/A
1      xxxxxxxxxx  xxxxxxxx      xxxxx  x

LOGIC
Ch-Pos  Name        Label         Assign bit
A3    xxxxxxxxxx  xxxxxx        x
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9.2.3 Setting the printer
Select [Printer Setup] on the [File] pull-down menu to set printer
conditions.

9.2.4 Examples of printouts
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9.2  Setting Data Printout
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When the CAN definition data setting window is opened, it appears on
top of the 8910 setting window. Both windows can be repositioned for
easy viewing by selecting [Cascade] or [Tiled] on the [Window] pull-
down menu.

9.3 Displaying Windows

<Cascade arrangement>

<Tiled arrangement>
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9.4  Password Setting
• The password protection function can be activated, requiring the set
password to be entered for opening a CAN definition data file.

• This function effectively prevents the inadvertent editing of data.

To set a password, select [Modify Password] on the [Edit] pull-down
menu to open the [Modify Password] dialog box.

To enable password setting, select the [Need Password] check box in
the dialog box, enter a password in the [Password] input box.

Click [OK].
The password must consist of only alphanumeric characters. After this
setting is entered, the password must be entered to open a CAN
definition data file.

<To disable the password protection function>
Deselect the check box.
• There will be no need to enter the password to open a CAN

definition data file after entering the setting.
• The password protection function is disabled in default installation

status, with no password required. There is no password protection
until a password is set.

9.4 Password Setting

1 Select [Edit] - [Modify Password].

2 Select the [Need Password] check box, and 
enter a password.

3 Click [OK].

A password can only be set when the program is in CAN definition data
editing mode.
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• You will be asked to provide the software version no. when making
an inquiry regarding the product.

• To check the software version, select [About 8910 Can Set] on the
[Help] pull-down menu.

9.5 Version Check



95
The 8910 can be connected to the 8826, 8841, or 8842 MEMORY
HiCORDER via the RS-232C interface for the transfer of 8910 setting
data to and from the Memory HiCorder.

The Memory HiCorder enable as follows:

• Change the 8910 output channel setting.
• Display the setting data list.
• Automatically set the scaling of the Memory HiCorder according to

scaling information in the CAN definition data.

Supported models and versions

Connection to
Memory
HiCorder Chapter 10

Memory HiCorder

8826 (Ver. 2.40 or later)

8841 (Ver. 2.50 or later)
8842 (Ver. 2.50 or later)

Communication interface

9557 RS-232C CARD

Versions of the Memory HiCorder older than the above must be upgraded. 
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10.1.1 Displaying the 8910 setting screen

Press the [SYSTEM] key of the 8826 until the [SYSTEM4-
INTERFACE] screen is shown.

Move the flashing cursor to the menu selection position
([INTERFSACE] indication at the top of the screen). This displays the
[CAN] GUI appears next to the [CH. SET] key.

10.1 Using the 8910 with the 8826 MEMORY 
HiCORDER

1 Display [SYSTEM 4 - INTERFACE] screen 
on the 8826.

[SYSTEM1-INTERFACE]→[SYSTEM2-INTERFACE]→
[SYSTEM3-INTERFACE]→[SYSTEM4-INTERFACE]→ 
(returns to the beginning)

Screen

2 Move the flashing cursor to [INTERFACE] 
indication.

<Interface Setting Screen>
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In this state, clicking the [CH. SET] key switches display from the
interface setting screen to the 8910 setting screen.

<To switch the screen>
To switch from the 8910 setting screen to the interface setting screen,
click the [CH. SET] key while the [INTERFACE] GUI is displayed next
to the [CH. SET] key.

3 Click the [CH. SET] key to display the 8910 
setting screen.

<8910 Setting Screen>

Display is switched each time you press the [CH. SET] key.CH. SET

Interface Setting
Screen

8910 Setting
Screen
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10.1.2 8910 setting screen
2.                                 3.

1.

4.

5.

6.

7.

8.

Item Description Reference

1. Block no. setting
Used to select a block for saving 
setting data. ❖ 10.1.3

2. Analog CH output 
setting section

Used to set and display CAN definition 
data to be output from an analog 
channel of the 8910.

❖ 10.1.4

3. Logic CH output 
setting section

Used to set and display CAN definition 
data to be output from a logic channel 
of the 8910.

❖ 10.1.5

4. ID trigger/ID filter 
setting display

Displays the ID trigger and ID filter 
settings.

-

5. Communication 
message display 
section

Displays the status of communication 
between the 8910 and 8826. ❖ 10.1.7

6. Screen selection 
GUI

Switches display between the 
interface setting screen and 8910 
setting screen.

❖ 10.1.1

7. List display GUI
Displays a list of registered CAN 
definition data. ❖ 10.1.6

8. Function key GUI

Used to make settings. The function 
varies depending on the position of the 
flashing cursor.

-
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10.1.3 Setting the block no.

• The 8826 can store the setting data of up to six 8910s. Each setting
data storage area is called a block.

• Move the flashing cursor to the [BLOCK NO.] indication, then use a
function key ([F1] or [F2]) to increment or decrement the number
from [1] to [6].

If there is no data in the selected block, the flashing cursor can only be
moved to the block no. selection section.
❖ How to transfer data from the 8910→(Section 10.1.7, 104p.)
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10.1.4 Setting analog channel output
•The cursor keys can be used to move
the cursor to any item indication except
those in the 8910 CH column.

•The function keys can be used to
change the value of a selected item.

Item Description Setting 
range

1. 8910 CH
Analog output channels (fixed) of the 
8910

1 to 12

2. Analog CH
output data

Used to select CAN definition data to 
be output from an analog channel of 
the 8910. The label name is displayed.

OFF, 
1 to registered 
data count

3. D/A conversion
setting

Used to set whether to perform D/A 
conversion based on bipolar (-5 to +5 
V) or monopolar (0 to +5 V) inside the
8910.

BI
(bipolar)
MONO
(monopolar)

4. 8826 input
channel

Used to set the channel of the 8826 for 
receiving data input. This is not a 
setting item for the 8910. This 
information is required to reflect the 
scaling value and signal name on the 
8826.

1 to 32

1. 2. 3. 4.

Setting changes made here are not reflected on the 8910 until data
transmission (Section 10.1.7, 104p.) is performed.
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• The [F3] (Scaling function key) is effective for items 2 to 4 above.
Clicking this function key automatically sets the scaling value for the
channel specified as the 8826 input channel according to the
content of CAN definition data as follows:
• Data length
• Sign setting
• D/A conversion setting

• And at the same time, the signal name contained in CAN definition
data as 8826 comment data.

• The scaling conversion bit rate and offset value of the 8826 are
obtained by using the following formula with the bit rate and offset
value contained in CAN definition data.

• In the following, the length of CAN definition data is n (bits), bit rate
is BitRate, and offset value is Offset.

For bipolar
Conversion bit rate : ((2n-1) × BitRate) / 10.0

Offset : Offset + ((2n-1) × BitRate) / 2.0
For monopolar
Conversion bit rate : ((2n-1) × BitRate) / 5.0
Offset : Offset

Without sign

With sign

For bipolar
Conversion bit rate : ((2n-1) × BitRate) / 10.0
Offset : Offset - BitRate / 2.0
For monopolar
Conversion bit rate : ((2n-1) × BitRate) / 5.0

Offset : Offset - 2n-1 × BitRate
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10.1.5 Setting logic channel output
•The cursor keys can be used to move the
cursor to any item indication except those in
the 8910 CH column.

•The function keys can be used to change
the value of a selected item.

•Clicking the [F3] (COMMENT function key)
automatically sets the signal name
contained in CAN definition data as 8826
comment data.

Item Description Setting 
range

1. 8910 CH
Logic output channels (fixed) of the 
8910

A0 to F3

2. Logic CH output
data

• Used to select CAN definition data
to be output from a logic channel of
the 8910.

• The label name is displayed.
• Each time the [F5] (ID TRIGGER

function key) is clicked, selection
toggles between the 8910 ID trigger
output channel and normal signal
output channel.

• When the ID trigger output channel
is selected, the ID trigger and
applicable ID are displayed.

OFF,
1 to registered 
data count,
ID trigger 
setting

3. Bit position
setting

When the selected CAN definition data 
is 2 bits or more, this setting is used to 
select the bits to be output.

0 to data length 
of applicable 
CAN definition 
data - 1

4. 8826 input
channel

Used to set the data input channel on 
the 8826. This is not a setting item for 
the 8910. This information is required 
to reflect the scaling value and signal 
name on the 8826.

A1 to H4

1. 2.      3.  4.

Setting changes made here are not reflected on the 8910 until data
transmission (Section 10.1.7, 104p.) is performed.
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10.1.6 Displaying the registration list
The CAN definition data downloaded into blocks can be displayed. On
the 8910 setting screen, the [LIST] GUI is shown next to the [VIEW]
key.
In this state, pressing the [VIEW] key switches display in the following
sequence:

Clicking any key other than the [VIEW] key closes the list display
window.

For up to 25 items of definition data 

Definition data
setting (1 to max.)

Scaling setting

List display OFF

(1 to max.)

For more than 26 items of definition

Definition data
setting (1 to 25)

Definition data
setting (26 to max.)

Scaling setting
(1 to 25)

Scaling setting
(26 to max.)

List display OFF

Setting display items of CAN definition data (from left)

Label name up to 16 alphanumeric characters

Message ID 0 to 1FFFFFFF (hexadecimal notation)

Start position 0 to 63

Data length 1 to 16 (bits)

Byte pattern U/L (Motorola), L/U (Motorola), L/U (Intel)

Sign Unsigned (without sign), 1-Signed (one's 
complement), 2-Signed (two's complement)

Input port CAN1 or CAN2
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10.1.7 Communication between the 8826 and 8910
• The RS-232C interface is used for communication between the

8826 and 8910.
• On the 8826 side, the RS-232C parameters are automatically set

upon communication, but the 9557 RS-232C CARD and connection
cable must be set and connected so that the RS-232C function of
the 8826 is ready for operation.

• In the following, "8826" refers to the "8826 installed with the 9557." 
❖ For further details → instruction manuals for the 8826 and 9557.

Setting display items of scaling (from left)

Label name up to 16 alphanumeric characters

Bit rate decimal value (exponential notation)

Offset decimal value (exponential notation)

Unit up to 8 characters

<Example of CAN definition data setting list display> <Example of scaling data setting list display>
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Follow the procedure below to receive data.

1. Connect the 8826 to the 8910 with the RS-232C cable.

2. Position the [ONLINE/OFFLINE] switch of the 8910 to [ONLINE] side.

3. On the 8910 setting screen of the 8826, select a block to receive data,
then click [F4] (8910 → RECORDER function key).

4. After the self-check function checks connectivity, the 8826 receives
data in follows order:

(1) The registration list (up to 50 items)
(2) Analog CH (12 channels)
(3) Logic CH (24 bits)

The data reception status is indicated in the communication message
display section at the lower left of the screen.

5. Once data is received, it is displayed on the screen and
communication terminates.
If data reception fails, the communication message display section
indicates “Can not connect.".

Receiving data from the 8910 

Communication message display section

Block No.

If the error massage 
appears

Check the cable for proper connection, and
that the [ONLINE/OFFLINE] switch of the
8910 is positioned to [ONLINE] side.
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Follow the procedure below to send data.

1. Connect the 8826 to the 8910 with the RS-232C cable.

2. Position the [ONLINE/OFFLINE] switch of the 8910 to [ONLINE] side.

3. On the 8910 setting screen of the 8826, select a block to which to
send data, then click [F5] (RECORDER → 8910 function key).

4. After the self-check function checks connectivity, the 8826 sends data
in following order:

(1) The registration list (up to 50 items)
(2) Analog CH (12 channels)
(3) Logic CH (24 bits)

The data send status is indicated in the communication message
display section at the lower left of the screen.

5. Once the data is transmitted, the communication message display
section is cleared and communication terminates.
If data transmission fails, the communication message display section
indicates "Can not connect.".

Sending data to the 8910

Communication message display section

Block No.

If the error massage 
appears

Check the cable for proper connection, and
that the [ONLINE/OFFLINE] switch of the
8910 is positioned to [ONLINE] side.
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10.1.8 Downloading an setting data file
An 8910 setting data file (with extension "cmu") created with the
“8910 CAN set program” software can be downloaded to the 8826.

Open the 8910 setting screen and select a block to which to transfer
the setting data.

Display the file screen and download the desired 8910 setting data
file.

1 Select a block.

2 Download the 8910 setting data file.
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3 The setting data is transferred to the 
selected block.

Note that executing the data read command deletes all existing data in the
block.
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10.2.1 Displaying the 8910 setting screen

Press the [SYSTEM] key of the 8841, 8842 until the [SYSTEM4-
INTERFACE] screen is shown.

Move the flashing cursor to the menu selection position
([INTERFACE] indication at the top of the screen). This displays the
[CAN] GUI next to the [CH. SET] key.

10.2 Using the 8910 with the 8841, 8842 
MEMORY HiCORDER

1 Display [SYSTEM 4 - INTERFACE] screen on 
the 8841, 8842

[SYSTEM1-INTERFACE]→[SYSTEM2-INTERFACE]→
[SYSTEM3-INTERFACE]→[SYSTEM4-INTERFACE]→ 
(returns to the beginning)

Screen

2 Move the flashing cursor to [INTERFACE] 
indication.

<Interface Setting Screen>
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In this state, clicking the [CH. SET] key switches display from the
interface setting screen to the 8910 setting screen.

<To switch the screen>
To switch from the 8910 setting screen to the interface setting screen,
click the [CH. SET] key shown next to the [INTERFACE] GUI.

3 Click the [CH. SET] key to display the 8910 
setting screen.

<8910 Setting Screen>

Display is switched each time you press the [CH. SET] key. 

Interface Setting
Screen

8910 Setting
Screen
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10.2.2 8910 setting screen

1. 2.      3.

4.
5.

6.

7.

Item Description Reference

1. Block no. setting
Used to select a block for saving 
setting data. ❖ 10.2.3

2. Analog CH output
setting section

Used to set and display CAN definition 
data to be output from an analog 
channel of the 8910.

❖ 10.2.4

3. Communication
message display
section

Indicates the status of communication 
between the 8910 and 8841, 8842. ❖ 10.2.7

4. Screen selection
GUI

Switches display between the 
interface setting screen and 8910 
setting screen.

❖ 10.2.1

5. List display GUI
Displays a list of registered CAN 
definition data.

❖ 10.2.6

6. Function key GUI
Used to make settings. The setting 
varies depending on the position of the 
flashing cursor.

-

7. Logic CH output
setting section

Used to set and display CAN definition 
data to be output from a logic channel 
of the 8910.

❖ 10.2.5
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10.2.3 Setting the block no.

• The 8841, 8842 can store setting data of up to six 8910s. Each
setting data storage area is called a block.

• Move the flashing cursor to the [BLOCK NO.] indication, then use a
function key ([F1] or [F2]) to increment or decrement the number
(from 1 to 6).

If there is no data in the selected block, the flashing cursor can only be
moved to the block no. selection section. 
❖ How to transfer data from the 8910 → (Section 10.2.7, 117p.)
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10.2.4 Setting analog channel output

• The setting items are shown below.
• The cursor keys can be used to move the cursor to any item

indication except those in the 8910 CH column.

• The [F3] (Scaling function key) is effective for items 2 to 4 above.
Clicking this function key automatically sets the scaling value for the
channel specified as the 8841, 8842 input channel according to the
content of CAN definition data as follows:
• Data length
• Sign setting
• D/A conversion setting

• And at the same time, the signal name contained in CAN definition
data as 8841, 8842 comment data.

• The scaling conversion bit rate and offset value of the 8841, 8842
are obtained by using the following formula with the bit rate and
offset value contained in CAN definition data.

Item Description Setting 
range

1. 8910 CH
Analog output channels (fixed) of the 
8910

1 to 12

2. Analog CH
output data

Used to select CAN definition data to 
be output from an analog channel of 
the 8910. The label name, position, 
byte pattern, data length, and sign are 
displayed.

OFF, 
1 to registered 
data count

3. D/A conversion
setting

Used to set whether to perform D/A 
conversion based on bipolar (-5 to +5 
V) or monopolar (0 to +5 V) inside the
8910.

BI
(bipolar)
MONO
(monopolar)

4. 8841, 8842 input
channel

Used to set the channel of the 8841, 
8842 for receiving data input. This is 
not a setting item for the 8910. This 
information is required to reflect the 
scaling value and signal name on the 
8841, 8842.

1 to 16

1. 2. 3. 4.
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• In the following, the length of CAN definition data is n (bits), bit rate
is BitRate, and offset value is Offset.

For bipolar
Conversion bit rate : ((2n-1) × BitRate) / 10.0
Offset : Offset + ((2n-1) × BitRate) / 2.0
For monopolar
Conversion bit rate : ((2n-1) × BitRate) / 5.0
Offset : Offset

Without sign

With sign

For bipolar
Conversion bit rate : ((2n-1) × BitRate) / 10.0
Offset : Offset - BitRate / 2.0
For monopolar
Conversion bit rate : ((2n-1) × BitRate) / 5.0

Offset : Offset - 2n-1 × BitRate

Setting changes made here are not reflected on the 8910 until data
transmission (Section 10.2.7, 117p.) is performed.
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10.2.5 Setting logic channel output

• The setting items are shown below.
• The cursor keys can be used to move the cursor to any item

indication except those in the 8910 CH column.

• The [F3] (COMMENT function key) is effective for items 2 to 4
above. Clicking this function key automatically sets the signal name
contained in CAN definition data as 8841, 8842 comment data.

Item Description Setting 
range

1. 8910 CH
Logic output channels (fixed) of the 
8910

A0 to F3

2. Logic CH output 
data

• Used to select CAN definition data 
to be output from a logic channel of 
the 8910.

• The label name is displayed.
• Each time the [F5] (ID TRIGGER 

function key) is clicked, selection 
toggles between the 8910 ID trigger 
output channel and normal signal 
output channel.

• When the ID trigger output channel 
is selected, the ID trigger and 
applicable ID are displayed.

OFF,
1 to registered 
data count,
ID trigger 
setting

3. Bit position 
setting

When the selected CAN definition data 
is 2 bits or more, this setting is used to 
select the bits to be output.

0 to data length 
of applicable 
CAN definition 
data - 1

4. 8841, 8842 input 
channel

Used to set the data input channel on 
the 8841, 8842. This is not a setting 
item for the 8910. This information is 
required to reflect the signal name on 
the 8841, 8842.

A1 to D4

1.      2.      3.  4.  1.     2.     3.  4.

Setting changes made here are not reflected on the 8910 until data
transmission (Section 10.2.7, 117p.) is performed.
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10.2.6 Displaying the registration list
The CAN definition data downloaded into blocks can be displayed.
On the 8910 setting screen, the [LIST] GUI is shown next to the
[LEVEL MONI] key. In this state, pressing the [LEVEL MONI] key
switches display in the following sequence:

For up to 25 items of definition data 

Definition data
setting (1 to max.)

Scaling setting

List display OFF

(1 to max.)

For more than 26 items of definition

Definition data
setting (1 to 25)

Definition data
setting (26 to max.)

Scaling setting
(1 to 25)

Scaling setting
(26 to max.)

List display OFF

<Example of CAN definition data setting list display> <Example of scaling data setting list display>
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The following information is displayed at the bottom of the list:

Clicking any key other than the [LEVEL MONI] key closes the list
display window.

10.2.7 Communication between the 8841, 8842 and 8910 
• The RS-232C interface is used for communication between the

8841, 8842 and 8910.
• On the 8841, 8842 side, the 9557 RS-232C CARD and connection

cable must be set and connected so that the RS-232C function of
the 8841, 8842 is ready for operation.

• In the following, the "8841, 8842" refers to the "8841, 8842 installed
with the 9557."

❖ For further details → instruction manuals for the 8841, 8842 and 9557.

Setting display items of CAN definition data (from left)

Label name up to 16 alphanumeric characters

Message ID 0 to 1FFFFFFF (hexadecimal notation)

Start position 0 to 63

Data length 1 to 16 (bits)

Byte pattern M (U/L Motorola), L (L/U Motorola), I (L/U Intel)

Sign US (without sign), 1S (one's complement),
2 S (two's complement)

Input port 1 (CAN1) or 2 (CAN2)

Setting display items of scaling (from left)

Bit rate decimal value (exponential notation)

Offset decimal value (exponential notation)

Unit up to 8 characters

ID trigger ON/OFF setting, and applicable ID (when ON is
selected)

ID filter STD, EXT, NON (for each input channel of the
8910)
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Follow the procedure below to receive data.

1. Connect the 8841, 8842 to the 8910 with the RS-232C cable.

2. Position the [ONLINE/OFFLINE] switch of the 8910 to [ONLINE] side.

3. On the 8910 setting screen of the 8841, 8842, select a block to receive
data, then click [F4] (8910 → RECORDER function key).

4. After the self-check function checks connectivity, the 8841, 8842
receives data in follows order:

(1) The registration list (up to 50 items)
(2) Analog CH (12 channels)
(3) Logic CH (24 bits)

The data reception status is indicated in the communication message
display section to the right of the block number indication.

5. Once data is received, it is displayed on the screen and
communication terminates.
If data reception fails, the communication message display section
indicates "Cannot connect to 8910.". 

Receiving data from the 8910 

If the error massage 
appears

Check the cable for proper connection, and
that the [ONLINE/OFFLINE] switch of the
8910  is positioned to [ONLINE] side.

The RS-232C parameters are automatically set in the 8841, 8842 at data
reception.

Block no. Communication message display

Click [F4] key.
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Follow the procedure below to send 8910 setting data stored in the
8841, 8842 to the 8910.

1. Connect the 8841, 8842 to the 8910 with the RS-232C cable.

2. Position the [ONLINE/OFFLINE] switch of the 8910 to [ONLINE] side..

3. On the 8910 setting screen of the 8841, 8842 select a block to which
to send data, then click [F5] (RECORDER → 8910 function key).

4. After the self-check function checks connectivity, the 8841, 8842
sends data in following order:

(1) The registration list (up to 50 items)
(2) Analog allocations (12 channels)
(3) Logic allocations (24 bits)

The data send status is indicated in the communication message
display section to the right of the block number indication.

5. Once the data is transmitted, the communication message display
section is cleared and communication terminates.
If data transmission fails, the communication message display section
indicates "Cannot connect to 8910.".

Sending data to the 8910

If the error massage 
appears

Check the cable for proper connection, and
that the [ONLINE/OFFLINE] switch of the
8910 is positioned to [ONLINE] side.

The RS-232C parameters are automatically set in the 8841, 8842 at data
transmission.
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10.2.8 Downloading a setting data file
An 8910 setting file (with extension "cmu") created with the ” 8910
CAN set program” software can be downloaded to the 8841, 8842.

Open the 8910 setting screen and select a block to which to transfer
the setting data.

Display the file screen, then download the desired 8910 setting data
file.

1 Select a block.

2 Download the 8910 setting data file.
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3 The setting data is transferred to the 
selected block.

Executing the data read command deletes all existing data in the block.
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11.1  General Specifications
Basic specifications

Specifications Chapter 11

11.1 General Specifications

Number of CAN input channels CAN 2 ch
CAN protocol CAN Ver. 2.0B (standard format, extended format)
CAN communication speed 125 k, 250 k, 500 k, 1 M bps (High-Speed CAN (ISO 11898)
CAN interface Listen-only
CAN input connector D-sub 9-pin, male connector (CiA-compliant)
Number of logic output channels Logic 6 ch - 24 bit (6 ch × 4 bit / ch = 24 bit)
Logic output format Unbalanced output (grounded on one side) (GND terminal shared with 

GND of main instrument)
Logic output voltage 0 to 5 V (LOW level: 0 to 0.5V, HIGH level: 4.5 to 5.0 V)
Logic output connector MINI DIN Round-type 9-pin connector
Number of analog output 
channels

Analog 12 ch

Analog output format Unbalanced output (grounded on one side) (GND terminal shared with 
GND of main instrument)

Analog output voltage -5 to + 5V
Analog output terminal BNC connector
Output D/A resolution 16 bit
DC amplitude accuracy ±0.1% f.s.
Temperature characteristic ±0.01% f.s./°C (typ.)
Output resistance 100Ω±10% (DC)
Analog output waveform Staircase output (without smoothing filter)
Response speed Within 1 ms

When one ID (at output interval of 3 ms or more) is acquired and its ID
assigned to all analog/logic channels, with the ID filter ON: the response
speed is the length of time from CAN message reception to completion of
all analog/logic outputs.

Backup All backup setting data is stored in nonvolatile memory.
Operating environment Max. 2000 m (6562 feet) height, indoors

Pollution degree 2
Operating temperature/humidity 
range

-10 to 55°C (14 to 131°F), 30 to 80%RH (with no condensation)

Storage temperature/humidity 
range

-20 to 70°C (-4 to 158°F), 10to 90%RH (with no condensation)

Product warranty period: 1 year.
Accuracy at 23 ± 5°C (73 ± 8.5°F), 30 to 80% RH after 30-minute 
warming-up time.
Period of guaranteed accuracy: 1 year.
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Display section

Operation section

External interfaces

9418-15 AC ADAPTER Accessory

Operating temperature/humidity 
range

0 to 40°C (32 to 104°F), 20 to 80%RH (with no condensation)

Storage temperature/humidity 
range

-20 to 80°C (-4 to 176°F), 10 to 95%RH (with no condensation)

Power supply 1. 9418-15 AC ADAPTER (Accessory) (Output 12 VDC±5%)
AC adapter rated power voltage: 100 to 240 VAC (Voltage fluctuations
of ±10% from the rated supply voltage are taken into account.)
AC adapter rated power frequency: 50/60 Hz

2. 10 to 30 VDC (Voltage fluctuations of ±10% from the rated supply voltage
are taken into account.)

3. Supply from CAN input connector (10 to 30 VDC) (Voltage fluctuations
of ±10% from the rated supply voltage are taken into account.)

Maximum rated power 10 VA
Power input terminal Power supply jack (center: positive) (GND terminal shared with GND of 

main instrument)
CAN input connector (2 channels) (GND terminal shared with GND of main 
instrument)

Dimensions Approx. 180W × 50H × 100D mm (7.09W × 1.97 H× 3.94D”)
(excluding projections)

Mass Approx. 940 g (33.2 oz.)
Effect of radiated radio-frequency 
electromagnetic field

±2% f.s. at 3 V/m

Effect of conductive radio-
frequency electromagnetic field

±2% f.s. at 3 V

Standards applying Safety: EN61010
EMC: EN61326 Class A
EN61000-3-2
EN61000-3-3

Screen LCD (with backlight)
LCD display resolution 20 characters × 2 lines, 5 × 8 dots/characters
LCD display language English
LCD backlight Auto OFF
Status display LEDs 4 LEDs (POWER, CAN, ONLINE, CAL)

Operation switch 3 setting keys (ESC, SEL, ENT), non-locking pushbutton switches
1 CAL key (CAL), non-locking pushbutton switch
ONLINE/OFFLINE selection slide switch
Power switch (common for three power supply lines)

RS-232C EIA RS-232C compliance (for condition setting)
RS input connector D-sub 9 pin female connector (for straight cable)
Transmission speed 19200 bps fixed
Communication content Communication of condition setting data with PC or MEMORY HiCORDER
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11.2 Specifications of Functions

ONLINE mode Communication between 8910 and external equipment (PC or Memory 
HiCorder) connected via RS-232C
Keys on the 8910 are disabled.

OFFLINE mode Stand-alone use of the 8910
1. CAN conversion mode

CAN messages transmitted via the CAN bus are converted to analog/
logic signals and output from specified channels.

2. CAL mode
When an analog channel is specified, the output alternates between 0%
and 100% at intervals of about 100 ms.
When a logic channel is specified, the output alternates between 0AH
(1010B) and 0.5H (0101B) at intervals of about 100 ms.

3. Setting mode
The data to be output from analog/logic channels is selected from the
8910 registration list.

Settings 1. CAN definition data
(1) CAN definition data setting

2. 8910 setting data
(2) CAN input port setting
(3) 8910 registration list setting
(4) Output channel list setting
(5) D/A conversion format setting (analog channels only)
(6) Bit position setting (logic channels only)
(7) ID trigger setting
(8)ID filter setting

Setting method 1. Settings entered by using "8910 CAN set program" on PC
(Used for above (1), (2), (3), (7), (8) settings)

2. Settings entered by using "8910 CAN set program" on PC, or
3. Settings entered by using Memory HiCorder, or
4. Settings entered by using the 8910
(Used for above (4), (5), (6) settings)

Setting data transfer 1. Transfer of setting data from PC to the 8910 via RS-232C
(The PC cannot read setting data of the 8910.)

2. Transfer of setting data from PC to Memory HiCorder (8841, 8842, 8826)
via media
(Setting data of the Memory HiCorder cannot be stored on media.)

3. Transfer of setting data from HiCorder to the 8910 via RS-232C
(The Memory HiCorder cannot read setting data of the 8910.)

Setting information confirmation Displayed on PC, Memory HiCorder, and the 8910
Scaling Supports only linear functions (by Memory HiCorder)
Trigger function ID trigger

(When the set ID is received, an "H" active pulse with a pulse width of 100 
μs is output from a specified logic channel.

Filter function ID filter
(By screening out IDs other than the one assigned to the output channel, 
acquisition performance is improved.)
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General specifications

Functions

11.3 Specifications of 8910 CAN Set Program 
(PC Application)

Type CD-R, one disc (Japanese/English 2 files) (including the "CAN setting
function")

System requirements CPU: Pentium 133 MHz or higher
RAM: 64 MB or more
HDD: 5 MB of free space or more
Supported OSs: Windows 95, Windows 98, Windows NT4.0 (SP3 or later), 
Windows ME, Windows 2000, Windows XP

Supported measuring equipment 8910 CAN ADAPTER

Settings 1. CAN definition data
(1) CAN definition data setting
-1. Item no. (1 to 300)
-2. CAN message ID (0 to 1fffffff H)
-3. Start bit (0 to 63)
-4. Data length (1 to 16)
-5. Data pattern (U/L (Motorola), L/U (Motorola), L/U (Intel))
-6. Sign (Unsigned, 1-Signed, 2-Signed)
-7. Signal name (up to 40 characters)
-8. Label name (up to 16 characters)
-9. Scaling unit (up to 8 characters)

-10. Scaling value (selected from "bit rate/offset value" and "maximum
value/minimum value")

2. 8910 setting data
(2) CAN input port setting
-1. Selection of input port no. (1, 2)
(3) 8910 registration list setting
-1. Selection of up to 50 items from CAN definition data
(4) Output channel setting
-1. Allocation of 8910 registration list to analog output channels (12

channels)
-2. Allocation of 8910 registration list to logic output channels (24 bits)
(5) D/A conversion format setting (analog channels only)
-1. Selection of bipolar (output of -5 V to 5 V) or monopolar (output of 0

V to 5 V)
(6) Bit position setting (logic channels only)
(7) ID trigger setting
-1. Selection of ON (pulse output based on ID trigger) or OFF (data

output), input of specified ID, designation of logic output channel
(8) ID filter setting (set individually for CAN input port 1 and CAN input 2)
-1. STD (standard format, ID filter ON), EXT (extended format, ID filter

ON), NON (mixed formats, ID filter OFF)
Number of setting items 1. CAN definition data: up to 300 items per file

2. 8910 registration list: up to 50 items
3. Output channel: up to 12 analog channels and 24 logic channel bits
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11.4  Specifications of CAN Setting Function (for Memory HiCorder)
General specifications

Functions

Display function 1. CAN definition data list display (of all CAN definition data setting items)
2. 8910 registration list display (item no., input port no., signal name, label 

name, unit, data length)
3. Analog output list display (ON/OFF, channel no., signal name, label 

name, unit, D/A conversion format)
4. Logic output list display (ON/OFF, channel no., signal name, label name, 

bit position, ID trigger setting)
Storage 1. CAN definition data (binary format, with extension "cdf")

2. 8910 setting data (all settings except for CAN definition data) (binary 
format, with extension "cmu")

Communication function Transfer of setting data to the 8910 via RS-232C (8910 setting data cannot 
be read.)
Transfer of setting data to Memory HiCorder via media (Memory HiCorder 
setting data cannot be stored on media.)

Model compatible with 
communication control

8910 CAN ADAPTER, 1 instrument (effective only when the 8910 is in 
ONLINE mode)

11.4 Specifications of CAN Setting Function 
(for Memory HiCorder)

Type CD-R, one disc (including "8910 CAN set program")
Supported measuring equipment 8826, 8841, 8842 (9557 RS-232C CARD required)

Settings 1. Output channel setting
(1) Allocation of 8910 registration list to analog output channels (12 

channels)
(2) Allocation of 8910 registration list to logic output channels (24 bits)

2. D/A conversion format (analog channels only)
(1)Selection of bipolar (output of -5 V to 5V) or monopolar (output of 0 V 

to 5 V)
3. Bit position setting (logic channels only)
4. Memory HiCorder channel setting (analog channels, logic channels)

(1)Correlation between 8910 output channels and Memory HiCorder 
input channels

Display function 8910 setting data display
Storage 8910 setting data x 6 blocks can be stored in internal backup memory of the 

Memory HiCorder.
Simultaneous storage upon Memory HiCorder channel setting (Data 
cannot be stored on media.)

Communication function Transfer of setting data to 8910 via RS-232C (8910 setting data can also 
be read.)
Transfer of setting data from PC via media (Memory HiCorder setting data 
cannot be stored on media.)

Automatic scaling function Automatic calculation of Memory HiCorder scaling setting based on 8910 
setting data



11.5  Accessories

128
• Instruction manual ...........................................................................1
• CD-R ("8910 CAN set program" software (Japanese/English 2 files) 

(for PC), CAN setting function (for Memory HiCorder)) ...................1
• RS-232C cable (D-sub 9-pin, male-female, straight cable) .............1
• 9418-15 AC ADAPTER ................................................................... 1
• Power cord ...................................................................................... 1
• 9713-01 CAN CABLE (one end unprocessed) ................................ 1

• 9713-01 CAN CABLE (one end unprocessed)
• 9713-02 CAN CABLE (For automotive connector)

(Since this part is made to order, check the specifications document
and delivery date.)

• 9714-01 LOGIC CABLE (one end unprocessed)
• 9714-02 LOGIC CABLE (for Memory HiCorder)
• 9165 CONNECTION CORD (Metal BNC - Metal BNC)
• L9217 CONNECTION CORD (Metal BNC - Insulated BNC)

(Insulated BNC for Memory HiCorder)
• 9557 RS-232C CARD (for Memory HiCorder)

11.5 Accessories

11.6 Options
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11.6  Options
11.6.1 9713-01 CAN CABLE (one end unprocessed)

Wire color Pin no. Name of signal 
received

- 1 NC
Green 2 CAN_L
Black 3 CAN_GND

- 4 NC
- 5 NC
- 6 NC

Red 7 CAN_H
- 8 NC

White 9 CAN_V+
- Shielded GND

12345

6789

Female connector (9 holes)

Operating temperature/humidity 
range

-10 to 55°C (14 to 131°F), 80%RH max. (with no condensation)

Storage temperature/humidity 
range

-20 to 70°C (-4 to 158°F), 90%RH max. (with no condensation)

Rated voltage 60 VDC
Rated current 2 A
Dimensions Approx. 2000 mm (78.7”)
Mass Approx. 110 g (3.5 oz.)
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11.6.2 9713-02 CAN CABLE (For automotive connector)
Since this part is made to order, check the specifications
document and delivery date.

Operating temperature/humidity 
range

-5 to 60°C (23 to 140°F), 90%RH max. (with no condensation)

Storage temperature/humidity 
range

-20 to 80°C (-4 to 176°F), 90%RH max. (with no condensation)

Rated voltage 60 VDC
Rated current 2 A
Dimensions Approx. 2000 mm (78.7”)
Mass Approx. 150 g (5.3 oz.)
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11.6  Options
11.6.3 9714-01 LOGIC CABLE (one end unprocessed)

Wire color Pin no. Name of signal 
received

Red 1 1 ch
Blue 2 2 ch

Yellow 3 3 ch
Purple 4 4 ch

- 5 NC
Green 6 GND

- 7 GND
- 8 GND
- 9 GND
- Shielded GND

3

7

1

5

2

6

9

4

8

Male connector (9 pins)

Operating temperature/humidity 
range

-10 to 55°C (14 to 131°F), 80%RH max. (with no condensation)

Storage temperature/humidity 
range

-20 to 70°C (-4 to 158°F), 90%RH max. (with no condensation)

Rated voltage 12 VDC
Rated current 1 A
Dimensions Approx. 1500 mm (59.1”)
Mass Approx. 60 g (2.1 oz.)
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11.6.4 9714-02 LOGIC CABLE (for Memory HiCorder)

Operating temperature/humidity 
range

-10 to 55°C (14 to 131°F), 80%RH max. (with no condensation)

Storage temperature/humidity 
range

-20 to 70°C (-4 to 158°F), 90%RH max. (with no condensation)

Rated voltage 12 VDC
Rated current 1 A
Dimensions Approx. 1540 mm (60.6”)
Mass Approx. 90 g (3.2 oz.)
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11.7  Specifications of Connectors
CAN connector D-Sub 17LE23090-27 (manufactured by DDK Ltd.)

RS-232C connector D-Sub 17LE13090-27 (manufactured by DDK Ltd.)

11.7 Specifications of Connectors

No. Name of signal No. Name of signal

1 NC 6 NC
2 CAN L 7 CAN H
3 CAN GND 8 NC
4 NC 9 CAN V+
5 NC Shielded GND

12345

6789

Male connector (9 pins)

No. Name of signal No. Name of signal

1 NC 6
Shorted-circuited 
with signal No. 4

2 TXD 7 CTS
3 RXD 8 RTS

4
Shorted-circuited 
with signal No. 6

9 NC

5 GND Shielded GND

Female connector (9 holes)

1 2 3 4 5

6 7 8 9

RTS and DTR are set to HI level at the factory.



11.7  Specifications of Connectors

134
Logic connector TCS7913-43-201 (manufactured by Hosiden Corp.)

Analog connector BNC BNC-R-PC (manufactured by Hirose Electric Co., 
Ltd.)

No. Name of signal No. Name of signal

1 1 CH 6 GND
2 2 CH 7 GND
3 3 CH 8 GND
4 4 CH 9 GND
5 NC Shielded GND

Female connector (9 holes)3 4 5

7

1 2

6

98
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12.1  Service and Cleaning
Service
• If damage is suspected, check the "Section 12.2 Troubleshooting"

before contacting your dealer or Hioki representative.
• When sending the instrument for repair, pack the instrument so that

it will not sustain damage during shipping, and include a description
of existing damage. We cannot accept responsibility for damage
incurred during shipping.

Cleaning
• To clean the instrument, wipe it gently with a soft cloth moistened

with water or mild detergent. Never use solvents such as benzene,
alcohol, acetone, ether, ketones, thinners or gasoline, as they can
deform and discolor the case.

• Wipe the LCD gently with a soft, dry cloth.

If the instrument does not seem to operate normally, check the
following points before requesting service.

If you cannot determine the cause of a problem, reset the system. This
returns all settings to the defaults (factory settings). After resetting the
system, transfer the setting data from the PC again.

Maintenance
and Service Chapter 12

12.1 Service and Cleaning

12.2 Troubleshooting

Problem Check

LED does not light when the instrument is
turned on. Is the AC adapter connected properly?

Keys on the main instrument are ineffective. Confirm that the [ONLINE/OFFLINE] switch is set to
the [ONLINE] side.

Cannot communicate with the PC. • Check the RS cable for proper connection.
• Check the communication settings on the PC.
• Confirm that the [ONLINE/OFFLINE] switch is

positioned to the [ONLINE] side.
Signal cannot be acquired from the CAN bus. • Check the RS cable for proper connection.

• Check the acquisition data settings.
• Confirm that the output channel is assigned with

acquisition data.
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System reset

1. Hold down the [ESC], [SEL], and [ENT] keys simultaneously, then turn
on the power switch.

2. The LCD on the main instrument indicates the following:

3. Press the [ENT] key to initialize the settings and return the product to
the default condition set at the factory.

SYSTEM RESET
NO->ESC YES->ENT
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